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About this document

The products IBM® WebSphere Business Integration Server Express and IBM®
WebSphere Business Integration Server Express Plus are made up of the following
components: InterChange Server Express, the associated Toolset Express,
CollaborationFoundation, and a set of software integration adapters. The tools in
Toolset Express help you to create, modify, and manage business processes. You
can choose from among the prepackaged adapters for your business processes that
span applications. The standard processes template--CollaborationFoundation--
allows you to quickly create customized processes.

This document describes installation, configuration, business object development,
and troubleshooting for the Adapter for XML.

Except where noted, all the information in this guide applies to both IBM®
WebSphere™ Business Integration Server Express and IBM® WebSphere™
Business Integration Server Express Plus. The term WebSphere Business Integration
Server Express and its variants refer to both products.

Audience

This document is for WebSphere consultants and customers who are implementing
the connector as part of a WebSphere business-integration system. To use the
information in this document, you should be knowledgeable in the following areas:

¢ Connector development
* Business object development
e HTTP and HTTPS based application architecture

Prerequisites for this document

You need to be familiar with the WebSphere Business Integration Server Express
Adapters system, business object development, and data handlers. You also need to
be familiar with the XML markup language and a schema language, either
document type definition (DTD) or XSDL (for schema documents).

Related documents

The complete set of documentation available with this product describes the
features and components common to all WebSphere Business Integration Server
Express installations, and includes reference material on specific components.

You can download, install, and view the documentation at the following site:
lhttp:/ /www.ibm.com /websphere /wbiserverexpress/infocenter]

Note: Important information about this product may be available in Technical
Support Technotes and Flashes issued after this document was published.
These can be found on the WebSphere Business Integration Support Web
site, [http: / /www.ibm.com /software/integration /websphere /support/|
Select the component area of interest and browse the Technotes and Flashes
sections.

© Copyright IBM Corp. 2004 vii
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Typographic conventions

viii

This document uses the following conventions:

courier font

bold
italic, italic
blue text

{1
[]

/,\

%Stext% and $text

ProductDir

Indicates a literal value, such as a command name, file
name, information that you type, or information that the
system prints on the screen.

Indicates a new term the first time that it appears.

Indicates a variable name or a cross-reference.

Blue text, which is visible only when you view the manual
online, indicates a cross-reference hyperlink. Click any blue
text to jump to the object of the reference.

In a syntax line, curly braces surround a set of options from
which you must choose one and only one.

In a syntax line, square brackets surround an optional
parameter.

In a syntax line, ellipses indicate a repetition of the previous
parameter. For example, option[,...] means that you can
enter multiple, comma-separated options.

In a naming convention, angle brackets surround individual
elements of a name to distinguish them from each other, as
in <server_name><connector_name>tmp.10g.

In this document, backslashes (\) are used as the convention
for directory paths for Windows. OS/400 and Linux use
forward slashes (/) for directory paths. All WebSphere
Business Integration Server Express system product path
names are relative to the directory where the product is
installed on your system.

Text within percent (%) signs indicates the value of the
Windows text system variable or user variable.

Text after the $ sign indicates the value of the text Linux or
05400 environment variable.

Represents the directory where the IBM WebSphere Business
Integration Server Express for Adapters product is installed.
The defaults for each platform are as follows:

Windows: IBM\WebSphereServer

OS/400: /QIBM/ProdData/WBIServer43/productLinux:
/home/${username}/IBM/WebSphereServer

Adapter for XML User Guide



New in this release

New in release 4.3.1

The Adapter for XML is now supported on the following operating systems:
» IBM OS/400 V5R2, V5R3

* Red Hat Enterprise AS Linux 3.0, Update 1

* SuSE Linux Enterprise Server 8.1 with SP3

* Microsoft Windows 2003

© Copyright IBM Corp. 2004
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Chapter 1. Overview of the XML adapter

This chapter describes the connector component of the IBM WebSphere Business
Integration Server Express Adapter for XML. The connector enables the integration
broker, InterChange Server Express, to exchange business objects with URLs by
using HTTP and HTTPS protocols. A URL can be any destination such as a remote
application or a servlet on a Web server.

Connectors consist of an application-specific component and the connector
framework. The application-specific component contains code tailored to a
particular application. The connector framework, whose code is common to all
connectors, acts as an intermediary between InterChange Server Express and the
application-specific component. The connector framework provides the following
services between InterChange Server Express and the application-specific
component:

* Receives and sends business objects

* Manages the exchange of start-up and administrative messages

This document contains information about the application-specific component and
connector framework. It refers to both of these components as the connector.

For more information about the relationship of InterChange Server Express to the
connector, see the System Administration Guide.

Note: When working in an XML environment, you can use the product-delivered
connector or you can build custom modules. See [“Planning a connector]|
[implementation” on page 23| for guidelines on deciding which to use.

This chapter contains the following sections:

« [“Connector components”]

* |“How the connector works” on page 4|

Connector components

The adapter is written in Java and consists of three components:
* Connector

¢ XML data handler

* Protocol handler (HTTP and HTTPS)

The connector interacts with the XML data handler. For more on data handlers, see
the Data Handler Guide.

ﬂlustrates the architecture of the connector components. The modular

design of the connector enables you to design custom components to replace the
product-delivered functionality.

© Copyright IBM Corp. 2004 1



Connector

Protocol handler

XML data
handler

Figure 1. Connector architecture

Connector

The connector passes business objects between InterChange Server Express and a
protocol handler. The connector:

* Receives business object requests from InterChange Server Express.

* Calls the Protocol Handler Framework and passes the URL string of a business
object to invoke the appropriate instance of the protocol handler.

* Passes business object requests to protocol handlers.

* Receives business object responses or success/failure return code from protocol
handlers. If the connector is using a synchronous protocol handler, then it
receives business object responses. If the connector is using an asynchronous
protocol handler, then it reports success or failure based on return code.

The primary methods used by the connector are init(), doVerbFor(), and
pol1ForEvents(). The init() method reads all configuration values from
InterChange Server Express’s repository, sets proxy names (HTTP and HTTPS) and
respective ports, and reads the Java class package names for the protocol handler
(JavaProtocolHandlerPkgs) and XML data handler (JavaDataHandlerPkgs), and the
value of properties of the data handler and protocol handler.

The doVerbFor() method handles the business object request/response operations.
When the connector receives a top-level business object from InterChange Server
Express, the doVerbFor() method extracts the request business object and the
destination URL. The doVerbFor() method then creates the appropriate protocol
handler instance.

When the connector receives a response from the destination URL, the doVerbFor()
method populates the response business object as a child of the top-level business
object and then returns the result to InterChange Server Express. In the connector,
all errors are propagated as exceptions and are handled through the connector,
where BON_FAIL is returned and Return Status Descriptor is set.

The pol1ForEvents () method is used for event notification. The connector has the
ability to check for events from a URL by using business objects. For more
information on event notification, see [“Event notification” on page 6|

The connector sets a static property to contain the name of the top-level data
handler meta-object as it is specified in the DataHandlerConfigMO connector
configuration property.

2 Adapter for XML User Guide



Protocol handler (HTTP and HTTPS)

The protocol handler enables the connector to communicate with a URL by using
the HTTP and HTTPS protocols. The protocol handler is an abstract base class that
extends the Java URLConnection class. This class contains abstract methods that can
be implemented to provide support for specific protocols, such as HTTP and
HTTPS. An instance of the protocol handler is created by the Protocol Handler
Framework, which is called by the connector.

The WebSphere Business Integration Server Express Adapter for XML includes
asynchronous and synchronous protocol handlers. Synchronous protocol handlers
return business objects from synchronous responses. Asynchronous protocol
handlers do not expect a response business object; they return only a success or
failure message based on the return code from the post operation. The
asynchronous protocol handler does not support event notification.

Note: By using the Protocol Handler Framework, you can add support for other
protocols such as FTP. The Protocol Handler Framework is an abstract base
class called CWURLConnection.

The Protocol Handler Framework creates an instance of a protocol handler, and the
connector passes a business object to the created instance. The protocol handler
extracts the content type (such as text/plain or text/xml) from the business object
and uses it to create an instance of the XML data handler.

When the protocol handler calls the createHandler() method, it passes in a content
type. The data handler create method passes the content type by replacing the
forward slash (/) characters with periods (.) and replacing all non-alphanumeric
characters with an underscore (_). Then the create method looks for an attribute in
the data handler top-level meta-object that matches the parsed string for the
content type. If it does not t find a match, the method builds the class name as
com.crossworlds.DataHandlers.modified content type

The protocol handler performs the following operations:

* Receives a business object from the connector and passes it to the XML data
handler. The protocol handler parses the MimeType attribute to determine which
data handler instance to create.

* Receives an XML stream from the XML data handler and then passes it to the
appropriate URL. The XML stream represents the request business object.

If the data handler parses an XML string, the protocol handler converts the XML
string into an XML stream before passing it to a URL.

* If it is synchronous, it then receives a response stream from a URL and passes it
back to an XML data handler, which converts it back into a WebSphere Business
Integration Server Express Adapters business object.

* If it is asynchronous, then it reports success or failure based on return code from
the request operation to the URL.

* Sends the response business object back to the connector.

If your implementation of the connector needs to support additional protocols, you
must build a custom protocol handler. For information on how to create a custom
protocol handler, see [Chapter 4, “Building a custom protocol handler,” on page 29)

Chapter 1. Overview of the XML adapter 3



How the connector works

The following sections describe how the connector processes business objects, how
meta-objects are used for configuration, and how the connector handles event
notification.

Business object processing

The connector uses request/response operations to pass data between it and a
URL. The connector receives business object requests from InterChange Server
Express and converts the requests into XML streams. The request stream is passed
to a URL by using the POST method, and a response stream is returned that may
or may not have similar content. The response stream is converted into a response
business object and returned with the original top-level business object to
InterChange Server Express. Note that the type of business object request can differ
from that of the business object response.

The complete request-response cycle is illustrated below.

Connector Firewall
! i
Request | i
Protocol :
roere HTTP or HTTPS
i % Response
! i
XML data |
handler

Figure 2. Business object processing

Request

When the connector receives a business object request from InterChange Server
Express, it must convert it into a request stream that can be passed by using the
appropriate protocol. The protocol handler and the XML data handler are used to
convert and send a request business object to a URL.

illustrates the request process.

Connector Firevyall
Request | !
Protocol ,i] HTTP or HTTPS
handler ! i
XML data | ‘
handler

Figure 3. Request processing

Specifically, when the connector receives a top-level business object from
InterChange Server Express, the following process flow occurs:
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1. The connector calls getAttrValue (“URL”) and retrieves the URL. It also calls
getAttrValue (“MimeType”) and getAttrValue (“BOPrefix”) to retrieve the
MimeType and BOPrefix attributes values from the business object.

2. The connector extracts the request business object from the top-level business
object.

3. The connector calls the appropriate protocol handler (HTTP or HTTPS) based
on the protocol specified in the URL field of the top-level business object, and
the protocol handler package name specified.

4. The protocol handler calls the appropriate data handler based on the
MimeType and BOPrefix attributes of the top-level business object (as
configured in the top-level meta-object).

5. The data handler converts the business object into a request stream and then
passes it back to the protocol handler.

6. The protocol handler sends the request stream to the destination URL specified
in the top-level business object or passes the return code.

Response

If you are using a synchronous protocol handler, then when the response business
object is returned from a URL, it is returned in the form of a response stream. If
you are using an asynchronous protocol handler, then return code is simply passed
back. The response processing is similar to the request processing, except the
response stream must be translated back into a business object.

Note: The response stream may not always be represented by the same business
object type as the request stream.

ﬂlustrates the process flow of the response business object returning to the
connector.

Connector Firevyall
| 1
Protocol HTTP or HTTPS
handler ; ; D—
_____ i i Response
XML data | ‘
handler
) A
Business ..
object T
definition

Figure 4. Process flow of data returning from a URL

Specifically, when the protocol handler receives a response stream from a URL, the
following process flow occurs if the MIME type is text/xml:

1. The protocol handler calls the getContentType ()method to retrieve the MIME
type value to determine which data handler to use.

2. The protocol handler calls the DataHandler class to create an instance of the
XML data handler.

Note that the data format in the response stream can be different from the data
format in the original request business object.

Chapter 1. Overview of the XML adapter 5



3. The protocol handler converts the response stream into a string, which the
protocol handler passes to the XML data handler.

4. The XML data handler obtains the business object name based on the message
content and extracts the data from the request stream (XML document) into a
business object.

5. The XML data handler passes the completed request business object to the
protocol handler.

6. The protocol handler passes the request business object to the connector, which
adds it to the original top-level business object.

7. The connector passes the original top-level business object containing the
request business object back to InterChange Server Express.

Event notification

For event notification, the connector uses business objects to retrieve events from a
URL. The connector polls a URL by sending a request XML document that is
returned as a response XML document. The response contains child business
objects that the connector passes to InterChange Server Express as events. Each
child business object is processed as one event. The asynchronous protocol handler
does not support event notification.

Note: Poll for events processing is the same as business object request processing
except that there is an additional step to extract event objects from the
response business object and send them to InterChange Server Express.

An event notification business object follows the same business object processing
operations as the request and response business objects of an XML business object.
All unsubscribed events are archived to a file in the WebSphere Business
Integration Server Express Adapters standard business object dump format.

To enable event notification, you need to define event notification business objects
and set up your URL (such as a Web servlet or cgi-bin script) to handle these
business objects. The connector uses the POST method to send an XML event
request document as a stream to the URL. The URL should read the XML
document as a stream from STDIN and write an XML document which contains
one or more event objects as a stream to STDOUT.

ﬂlustrates the basic process of event notification.

Request
Post »( STDIN
XML

connector

URL

<
STDOUT
Response

Figure 5. Event notification process

For more information on defining business objects, see [Chapter 3, “Developing]
business objects for the connector,” on page 23

Processing locale-dependent data

The connector has been internationalized so that it can support double-byte
character sets, and deliver message text in the specified language. When the

6 Adapter for XML User Guide



connector transfers data from a location that uses one character code to a location
that uses a different code set, it performs character conversion to preserve the
meaning of the data. The Java run-time environment within the Java Virtual
Machine (JVM) represents data in the Unicode character code set. Unicode contains
encoding for characters in most known character code sets (both single-byte and
multibyte). Most components in the WebSphere business integration system are
written in Java. Therefore, when data is transferred between most integration
components, there is no need for character conversion. To log error and
informational messages in the appropriate language and for the appropriate
country or territory, configure the Locale standard configuration property for your
environment. For more information on configuration properties, see

[“Standard configuration properties,” on page 35

Chapter 1. Overview of the XML adapter 7
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Chapter 2. Installing and configuring the connector

This chapter describes the process of installing and configuring the connector. It
contains the following sections:

» [“Prerequisites for this document” on page vii|
* |“Installing the XML adapter”
» [“Configuring the connector” on page 12|

+ [“Configuring top-level meta-objects for the data handler” on page 15

» [“Common configuration tasks” on page 16|

* |“Specitying a data handler” on page 16

. "’Creating multiple connector instances” on page 17]

« |“Starting the connector” on page 18]

+ |“Stopping the connector” on page 20|

Prerequisites

The connector runs on:

* Microsoft Windows 2000

* Microsoft Windows 2003

» IBM OS/400 V5R2, V5R3

* Red Hat Enterprise AS Linux 3.0, Update 1
* SuSE Linux Enterprise Server 8.1 with SP3

Installing the XML adapter

For information on installing the adapter, refer to the WebSphere Business
Integration Server Express installation guide for Windows, for Linux, or for
0S/400, located in the WebSphere Business Integration Server Express Infocenter at
the following site:

lhttp:/ /www.ibm.com /websphere /wbiserverexpress/infocenter]|

Installed file structure

The following subsections describe the installed file structure of the adapter on
Windows, OS/400, and Linux platforms.

For instructions on installing the adapter on these systems, see the WebSphere
Business Integration Server Express installation guide for Windows, for Linux, or
for OS/400. [Table 1 on page 10| describes the Windows file structures, |Tab1e 2 OEI
IEage l(] describes the OS/400 file structures, and [Table 3 on page 11| describes the
Linux file structures used by the connector.

For more information on installing the connector component, refer to the following
guides:

* Quick Start Guide

* WebSphere Business Integration Server Express installation guide for Windows,
for Linux, or for OS/400

© Copyright IBM Corp. 2004 9
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Installed file structure for Windows

Table 1. Installed Windows file structure for the connector

Subdirectory of %ProductDir%

Description

connectors \ XML

Contains the connector CWXML jar,
CWProtocolHandler jar, start_ XML.bat and
start_ XML _service.bat files.

connectors \ XML\ Dependencies\Sun

Contains jcert.jar, jnet.jar, and jsse.jar files
that are required for https connections.

connectors \messages

Contains the XMLConnector.txt file.

repository \ XML

Contains the CN_XML.txt file.

connectors \XML\Samples

Contains java and xml files and sample
business objects used for testing.

\lib

Contains the WBIA. jar file.

\bin

Contains the CWConnEnv.bat file.

Installed file structure for 0S/400

Table 2. Installed OS/400 file structure for the connector

Subdirectory of %ProductDir%

Description

connectors/ XML

Contains the connector CWXML jar,
CWProtocolHandlerjar and start XML.sh
files.

connectors/XML/Dependencies/Sun

Contains the mail jar file.

/QIBM /UserData/WBIServer43

Location for jcertjar, jnet.jar and jssejar files
that are required for https connections.

To use the Adapter for XML with your
0S/400 system, you must obtain the
appropriate jssejar, jnetjar, and jcert.jar. files
for use with IBM OS/400 V5R2, V5R3 and
add them to this directory. These files are
available as downloads from the Sun web
site at:

http:/ /java.sun.com/products/jsse/.

To set up these files, see the steps following
this table.

connectors/messages

Contains the XMLConnector.txt file.

repository /XML

Contains the CN_XML.txt file.

connectors/XML/Samples

Contains java and xml files and sample
business objects used for testing.

/lib

Contains the WBIA. jar file.

/bin

Contains the CWConnEnv.sh file.

To use the XML adapter with encryption on OS/400, you must manually install
some jar files that are not shipped with this product.

Perform the following steps to install the jar files in /QIBM/UserData/WBIServer43

to use the adapter with OS/400:

10 Adapter for XML User Guide




. Obtain the appropriate jsse jar, jnet.jar, and jcert.jar. files for use with IBM
0S/400 V5R2, V5R3 and from the Sun web site at:
http:/ /java.sun.com/products/jsse/

. Unzip the jsse jar to hard-disk which creates a jsse product directory. Under the
jsse directory there is a /lib directory (for example: \jssel.0.3_03\lib\) that
contains the necessary jsse jars to run the adapter.

. Copy the three jar files in the /lib directory to the OS/400 IFS in the following
location:

/QIBM /UserData/WBIServer43

(you can use Windows Explorer and copy to the IFS mapped drive).

. After the jars are copied to IFS, the owner of the jar files should be changed to
QWBISVR43 with the following CL commands:

CHGOWN OB]J("/QIBM/UserData/WBIServer43/jnet.jar")
NEWOWN(QWBISVR43) RVKOLDAUT(*YES)

CHGOWN OB]J("/QIBM/UserData/WBIServer43/jcert.jar’)
NEWOWN(QWBISVR43) RVKOLDAUT(*YES)

CHGOWN OB]J("/QIBM/UserData/WBIServer43/jsse.jar’)
NEWOWN(QWBISVR43) RVKOLDAUT(*YES)

. The start_XML.sh script must be edited to include the jar files in the classpath.

Edit the following file:
/QIBM/UserData/WBIServer43/<ICSName>/connectors/
<XMLBasedConnector>/start_ XML.sh

- where <ICSName> is the name of the ICS server on OS/400 for which the
adapter is being configured for

- where <XMLBasedConnector> is an XML connector

for example: "XMLConnector’ (for the default), or 'MyXMLConnector if the
user created a custom XML adaper named MyXMLConnector)

Uncomment (remove the hash "#" character at the beginning of the line) line 30
to read:

export JAVA_JSSE=/QIBM /UserData/WBIServer43 /jcert.jar:/QIBM /UserData/
WBIServer43/jnet.jar:/ QIBM/UserData/WBIServer43/jsse.jar

Uncomment line 43 to read:
export JCLASSES=${JCLASSES}:${JAVA_JSSE}

Installed file structure for Linux

Table 3. Installed Linux file structure for the connector

Subdirectory of %ProductDir%

Description

connectors/ XML

Contains the connector
CWXML jar,CWProtocolHandlerjar and
start_XML.sh files.

connectors/XML/Dependencies/Sun

Contains jcert.jar, jnet.jar, and jsse.jar files
that are required for https connections.

connectors/messages

Contains the XMLConnector.txt file.

repository /XML

Contains the CN_XML.txt file.

connectors/XML/Samples

Contains java and xml files and sample
business objects used for testing.

/lib

Contains the WBIA. jar file.

/bin

Contains the CWConnEnv.sh file.

Chapter 2. Installing and configuring the connector 11



Installer adds an icon for the connector file to the IBM WebSphere Business
Integration Adapters menu. For a fast way to start the connector, create a shortcut
to this file on the desktop.

Configuring the connector

Using InterChange Server Express, you configure connector properties from
Connector Configurator Express, which you access from System Manager.

Configuring the data handler

Configure the meta-objects used for the XML data handler. For information on
configuring meta obijects, see [“Configuring top-level meta-objects for the datal
lhandler” on page 15

Standard connector properties

Standard configuration properties provide information that all connectors use. See
[Appendix A, “Standard configuration properties,” on page 35| for documentation of
these properties.

provides information specific to this connector about a configuration
property in the appendix.

Table 4. Property information specific to this connector

Property Note
CharacterEncoding This connector does not use this property.
Locale Because this connector has been internationalized, you

can change the value of this property.

You must provide a value for the AppTlicationName configuration property before
running the connector. You also must set at least the following standard connector
configuration properties before running the connector.

* AgentTraceLevel

* ApplicationName

* ControllerStoreAndForwardMode
* ControllerTraceLevel

* DeliveryTransport

Connector-specific properties

Connector-specific configuration properties provide information needed by the
connector at run time. Connector-specific properties also provide a way of
changing static information or logic within the connector without having to recode
and rebuild the connector.

lists the connector-specific configuration properties for the connector. See
the section that follows for explanations of the properties.
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Table 5. Connector-specific configuration properties

Name Possible values Default value Required?
[ArchiveDirectory] archive directory name \connectors\xml\ archive
[DataHandlerConfigMO| data handler meta-object MO_DataHandler_ Default YES

name

http host name

http proxy port 80

Set the property to one of

the values in |iable 6 onl

lpage 14}

[HttpsProxyHos https host name

HttpsProxyPori https proxy port 443

avaProtocolHandlerPkes| protocol handler name com.crossworlds. connectors.utils. YES
ProtocolHandlers

MaxNumRetriesl positive integer 10

PollingBusinessObjectsl business object names

ReturnBusObjResponse true or false true

SecurityProvide SSL implementation com.sun.net.ssl.internal.ssl.Provider, YES
sun.security.provider.Sun
(To use the Adapter for XML with
your OS/400 system, you must
obtain the appropriate jsse jar,
jnet.jar, and jcert.jar. files for use
with IBM OS/400 V5R2, V5R3 and
add them to the
/QIBM/UserData/WBIServer43
directory. These files are available
as downloads from the Sun web
site at:
http:/ /java.sun.com/products/jsse.)

[UseCaches| true or false false
[UseDefault: true or false false

UseDigitalSignature| true or false false

ArchiveDirectory

Directory containing archived events. Each event can be identified by its business
object name and verb. By default, the create verb is appended to the business
object name. The default is \connectors\xml\ archive.

DataHandlerConfigMO

Name of the top-level meta-object that the XML connector uses to determine its
data handler support. This meta-object must contain the name of the child
meta-object that the XML data handler uses to set configuration properties. This
property is also used by the DataHandler base class to determine which
DataHandler class to instantiate for a particular content type. The default is
MO_DataHandler_ Default. For more information, see [“Configuring top-levell
imeta-obijects for the data handler” on page 15

HttpProxyHost
Name of the host that acts as the proxy for HTTP. This property is required only if
the network uses a proxy server that uses the HTTP protocol.

HttpProxyPort

Proxy port number used to connect HTTP. This property is required only if the
network uses a proxy server that uses the HTTP protocol. The default port number
is 80.
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HttpsDebug
Setting that determines what debugging information is generated for the HTTPS
session. lists the HTTPS debug values for the HTTPS protocol handler.

Table 6. HttpsDebug Values

Name Meaning

all Turn on all debugging

data Hex dump of each handshake message. It can be used to widen
handshake debugging.

handshake Print each handshake message. It can be used with SSL.

keygen Print key generation data. It can be used with SSL.

plaintext Hex dump of record plain text. It can be used to extend record
debugging.

record Enable per-record tracing. It can be used with SSL.

session Print session activity. It can be used with SSL.

ssl Turn on SSL debugging only.

verbose Print verbose handshake message. It can be used to extend record
debugging.

HttpsProxyHost

HTTPS proxy machine name. This property is required only if the network uses a
proxy server that uses the HTTPS protocol.

HttpsProxyPort
Proxy port number used to connect HTTPS. This property is required only if the
network uses a proxy server that uses the HTTPS protocol.

JavaProtocolHandlerPkgs

If this attribute is present, it specifies the packages that are used as protocol
handlers, instead of the default Java handler. These classes must conform to Java’s
Protocol Handler Framework. For example, to use a protocol handler named
com.mycompany.http (for HTTP), set this field to com.mycompany. Also make sure
that the . jar files of the corresponding class are in your classpath.

For more information on Java Protocol Handlers, see the tutorial at the following
URL:

http:/ /developer.java.sun.com/developer/onlineTraining / protocolhandlers/

It is also possible to specify multiple packages for this value separated by vertical
bars, “1”. For example, com.crossworlds.Protocol Handlers | com.mycompany

WebSphere Business Integration Server Express Adapter delivers two packages:

e com.crossworlds.connectors.utils.ProtocolHandlers (synchronous protocol
handler)

* com.crossworlds.connectors.utils.ProtocolHandlers.async (asynchronous
protocol handler)

The default is com.crossworlds.connectors.utils.ProtocolHandlers.

MaxNumRetries

Specifies the number of retries to attempt after the asynchronous protocol handler
does not receive a response from the destination URL. This property is used only
by the asynchronous protocol handler. If you do not specify a value, this property
defaults to zero.
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PollingBusinessObjects

Business objects used for event notification. Separate multiple entries with a
comma (For example, XMLPoll_Cust, XMLPoll_Order). Each business object must
be supported by the connector. This property is required if the connector is set up
for event notification.

ReturnBusObjResponse

Determines whether the connector expects a business object to be returned from
the protocol handler.If the value is set to true, then the connector expects a
business object. If the value is set to false, then the connector does not expect a
business object. It expects only a response of success or failure. The default is true.

Note: If you are configuring the asynchronous protocol handler, then the value
must be set to false, because the asynchronous protocol handler does not
expect a business object response.

SecurityProvider

Used by HTTPS during the SSL handshake. Comma-separated values of this
attribute determine which SSL implementation to use when connecting to HTTPS
URLs. If no value is set, HTTPS connections do not work. The default value is
com.sun.net.ssl.internal.ss1.Provider, sun.security.provider.Sun.

UseCaches

If this attribute is set to false, the connector attempts to retrieve a non-cached
version of XML documents. This is merely a request; it cannot be strictly enforced
by the connector. Set this value to true to retrieve cached XML documents only.

UseDefaults

On a Create operation, if UseDefaults is set to true, the connector checks whether
a valid value or a default value is provided for each isRequired business object
attribute. If a value is provided, the Create operation succeeds. If the parameter is
set to false, the connector checks only for a valid value and causes the Create
operation to fail if it is not provided. The default is false.

UseDigitalSignature

Specifies whether a digital signature length (0 in binary) is added to the end of a
message sent by using the HTTP or HTTPS protocol. If your connector supports
digital signatures, set this property to true. The default is false.

Note: The product-provided connector does not support digital signatures.

Configuring top-level meta-objects for the data handler

Meta-objects are business objects that contain configuration information. A data
handler meta-object contains information to configure a data handler. The
connector uses the information in the data handler meta-object to create an
instance of the XML data handler.

Before running the connector, you must set up a data handler meta-object that
specifies what data handler the connector will use based on the MIME type. When
the connector receives a business object request, it uses information from the
meta-object to dynamically create an instance of the appropriate data handler.

The connector gets the name of the top-level data handler meta-object from the

connector configuration property DataHandlerConfigMO. The top-level meta-object
is a hierarchical business object that can contain any number of child objects. Each
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child object is a flat object that represents a specific data handler instance. Child
meta-objects have attributes that provide configuration values that enable a data
handler instance to do its work. Different types of data handlers require different
configuration properties, so the child meta-objects that support specific handlers
have different attributes.

The XML connector uses the XML data handler to convert between business
objects and XML documents. To configure the XML data handler for the connector,
do the following:

* Set up the top-level data handler meta-object to have an attribute for each MIME
type that the connector supports. The attribute name should be the name of the
MIME type. The attribute represents a child meta-object for a data handler
instance.

For the XML connector, make sure that top-level meta-object contains an
attribute for the text/xml MIME type. This attribute must also list the name of
the child meta-object for the XML data handler.

* Set the default attribute values in each child meta-object. The configuration
properties for the WebSphere Business Integration Server Express Adapter data
handlers are described in the Data Handler Guide.

In the child meta-object for the XML data handler, set the appropriate default
attribute values.

For detailed information on setting up meta-objects for individual data handlers,
see the Data Handler Guide.

Note: For the connector to instantiate a data handler, the data handler top-level
meta-object must be part of the connector’s supported objects list.

Common configuration tasks

This section describes common configuration tasks for the connector.

Setting up event notification
To enable event notification for the connector, follow these steps:

1. Create a top-level business object containing a child request and a response
business object.

2. Configure your URL to handle the structure of the request and response
business objects. For more information on defining business objects, see
[Chapter 3, “Developing business objects for the connector,” on page 23|

3. After you have defined your event notification business objects, set the
PollingBusinessObjects and ArchiveDirectory configuration properties using
Connector Configurator Express, which you access from System Manager.

Specifying a data handler

To specify a data handler to be used by the XML connector, use the following

steps.

1. Determine the types of data formats that the connector will support.
By default, the connector uses the XML data handler for the text.xml MIME
type. If you are converting between business objects and some other MIME
type, make sure that the MIME type is an attribute in the top-level
data-handler meta-object (by default, MO_DataHandler_Default). Only one data
handler can be used to convert any given format type.
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2. Determine which data handler (or data handlers) the connector will use.

The top-level data-handler meta-object associates MIME types with a child
data-handler meta-object. The child data-handler meta-object determines which
data handler is instantiated.

3. Use Business Object Designer Express to modify the data-handler meta-objects.

Note: You can launch Business Object Designer Express from within System
Manager.

4. In Connector Configurator Express or System Manager, add the data handler
top-level meta-object to the list of supported objects for the connector. If the
connector is not subscribed to the top-level data-handler meta-object, the
connector does not load the meta-object when started.

5. Specify the name of the top-level data-handler meta-object in the connector
DataHandlerConfigM0 configuration property. The product-delivered default is
the MO_DataHandler_Default meta-object.

For more information about the data-handler meta-objects, see the Data Handler
Guide.

Creating multiple connector instances

Note: When you create an additional instance of this adapter (or any adapter that
is supplied with WebSphere Business Integration Server Express or Express
Plus), that instance of the adapter is counted as a separate adapter by the
licensing function that limits the total number of adapters that can be
deployed.

You can set your system up to create and run multiple instances of a connector by
following the steps below. You must:

* Create a new directory for the connector instance

* Make sure you have the requisite business object definitions
* Create a new connector definition file

* Create a new start-up script

Create a new directory

You must create a connector directory for each connector instance. This connector
directory should be named:

ProductDir\connectors\connectorInstance
where connectorInstance uniquely identifies the connector instance.

If the connector has any connector-specific meta-objects, you must create a
meta-object for the connector instance. If you save the meta-object as a file, create
this directory and store the file here:

ProductDir\repository\connectorInstance

Create business object definitions
If the business object definitions for each connector instance do not already exist
within the project, you must create them.

1. If you need to modify business object definitions that are associated with the
initial connector, copy the appropriate files and use Business Object Designer
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Express to import them. You can copy any of the files for the initial connector.
Just rename them if you make changes to them.

2. Files for the initial connector should reside in the following directory:
ProductDir\repository\initialConnectorInstance

Any additional files you create should be in the appropriate connectorInstance
subdirectory of ProductDir\repository.

Create a connector definition
You create a configuration file (connector definition) for the connector instance in
Connector Configurator Express. To do so:

1. Copy the initial connector’s configuration file (connector definition) and rename
it.

2. Make sure each connector instance correctly lists its supported business objects
(and any associated meta-objects).

3. Customize any connector properties as appropriate.

Create a start-up script
To create a start-up script:

1. Copy the initial connector’s start-up script and name it to include the name of
the connector directory:

dirname

2. Put this start-up script in the connector directory you created in

[directory” on page 17

3. (For Windows only.) Create a start-up script shortcut.

4. (For Windows only.) Copy the initial connector’s shortcut text and change the
name of the initial connector (in the command line) to match the name of the
new connector instance.

5. (For OS/400 only.) Create a job description for the connector using the
information below:
CRTDUPOB]J OBJ(QWBIEMAILC) FROMLIB(QWBISVR43) OBJTYPE(*JOBD)
TOLIB(QWBISVR43) NEWOBJ(newconnname) where newconnname is a
10-character name that you use for the job description for your new connector

6. (For OS/400 only.) Add the new connector to the WebSphere Business
Integration Console. For information about the WebSphere Business Integration
Console, refer to the online help provided with the Console.

You can now run both instances of the connector on your integration server at the
same time.

Starting the connector

A connector must be explicitly started using its connector start-up script. The
start-up script should reside in the connector’s run-time directory:

ProductDir\connectors\connName

where connName identifies the connector. The name of the start-up script depends
on the operating-system platform, as shows.

Table 7. Start-up scripts for a connector

Operating system Start-up script

Windows start_connName .bat
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Table 7. Start-up scripts for a connector (continued)

Operating system Start-up script
0S/400 start_connName.sh
Linux connector_manager -start connName WebSphereICSName

| [-cConfigFile]

where connName is the name of the connector,
WebSphereICSName is the name of the WebSphere
InterChange Server Express instance, and configFile is the
name of the configuration file to be used during startup.
This script sets environmental variables and starts the
start_connName . sh start-up script automatically. You do not
need to run the start-up script manually.

For more information on how to start a connector, including the command-line
start-up options, refer to the System Administration Guide.

Invoking the start-up script on Windows

On Windows platforms, you can invoke the connector start-up script in the
following ways:

e From System Monitor

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

¢ From the Start menu

— Select Program>IBM WebSphere Business Integration
Express>Adapters>Connectors>your_connector_name.
By default, the program name is “IBM WebSphere Business Integration
Express.” However, it can be customized. Alternatively, you can create a
desktop shortcut to your connector.

— On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector starts when the Windows system boots (for
an Auto service) or when you start the service through the Windows Services
window (for a Manual service).

* From the command line
start_connName connName WebSphereICSName [-cconfigFile ]

where connName is the name of the connector and WebSphereICSName is the
name of the InterChange Server Express instance. By default, the name of the
InterChange Server Express instance is WebSpherelCS.

Invoking the start-up script on 0S/400

On OS/400 platforms, you can invoke the connector start-up script in the

following ways:

* From Windows
Where the WebSphere Business Integration Server Express Console is installed,
select Programs>IBM WebSphere Business Integration Console >Console. Then,
specify the OS/400 system name or IP address and a user profile and password
that has *JOBCTL special authority.Select the connName adapter from the list of
adapters and select the Start Adapter button.

* From the OS/400 command line
In Batch mode: You need to run CL Command QSH and from the QSHELL
environment run /QIBM/ProdData/WBIServer43/bin/submit_adapter.sh
connName WebSphereICSName pathToConnNameStartScript jobDescriptionName,
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where connName is the connector name, WebSphereICSName is the InterChange
Server Express server name (default is QWBIDFT), pathToConnNameStartScript is
the full path to the connector start script, jobDescriptionName is the name of the
job description to use in the QWBISVR43 library.

In interactive mode: You need to run CL command QSH and from the QSHELL
environment, run
/QIBM/UserData/WBIServer43/WebSphereICSName/ connectors
/connName /start_connName.sh connName WebSphereICSName
[-cConfigFile] where connName is the name of your connector and
WebSphereICSName is the name of the Interchange Server Express instance.

¢ From System Monitor

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

Note: To start with TCP/IP servers, use this command:
/QIBM/ProdData/WBIServer43/bin/add_autostart_adapter.sh
with the following parameters in this order: connName,
WebSphereICSName, pathToConnNameStartScript,
and jobDescriptionName as explained on the previous page.

Invoking the start-up script on Linux
On Linux platforms, you can invoke the connector start-up script in the following
way:
* connector_manager -start connName WebSphereICSName [-cConfigFile]

where connName is the name of the connector and WebSphereICSName is the
name of WebSphere InterChange Server Express.

Stopping the connector

The way to stop a connector depends on the way that the connector was started.

Stopping the connector from Windows
On Windows platforms, you can stop the connector in the following ways:
* From System Monitor

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

* Activate the connector window, and type "q" and then press Enter.

e If the connector started as a Windows service, you can stop it through Control
Panel (Control panel>Administrative Tools>Services>).

Stopping the connector from 0S/400
On OS/400 platforms, you can stop the connector in the following ways:
* From the WebSphere Business Integration Console or command line

If you started the connector using the WebSphere Business Integration Console
or using the "submit_adapter.sh” script in QSHELL, from the OS/400 command
entry, use the CL Command WRKACTJOB SBS(QWBISVR43) to display the jobs
to the Server Express product. Scroll the list to find the job with a jobname that
matches the job description for the connector. For example, for the e-Mail
connector the jobname is QWBIEMAILC

Select option 4 on this job, and press F4 to get the prompt for the ENDJOB
command. Then specify *IMMED for the Option parameter and press enter.
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 If you used the start_connName.sh script to start the adapter from QSHELL,
press F3 to end the connector.

* From System Monitor

You can load, activate, deactivate, pause, shutdown, or delete a connector using
this tool.

Stopping the connector from Linux

On Linux systems, connectors run in the background so they have no separate
window. Instead, run the following command to stop the connector:

connector_manager connName -stop serverName

where connName is the name of the connector and serverName is the InterChange
Server Express instance.

Chapter 2. Installing and configuring the connector 21



22 Adapter for XML User Guide



Chapter 3. Developing business objects for the connector

This chapter describes the structure of a top-level business object passed by the
connector. It also describes the required attributes and describes how the connector
processes the top-level business object. It contains the following sections:

+ [“Planning a connector implementation”|

» |“Connector business object structure” on page 24|

» [“Business objects for event notification” on page 27|

* [“Business objects based on XML DTDs or schema documents” on page 28|

Planning a connector implementation

The connector is designed in a modular fashion so that components can be
replaced or added without compromising the integrity of the connector. Before you
begin configuring the connector and its components, take the time to analyze the
system you need to develop.

Use the following information to determine whether you can use the connector
components unchanged as they are delivered with the product. If the functionality
of a component of the connector does not meet your needs, you can replace it with

a custom component. For example, you might need to implement a custom data
handler if your application expects data types other than XML.

Use to determine whether you can use the connector components as
delivered or whether you have to create a custom component.

Table 8. Using a WebSphere Business Integration Server Express Adapter component or building a custom

component

Use WebSphere Business
Integration Server Express

Adapter-delivered component...

Synchronous protocol handler
(HTTP/HTTPS)

Asynchronous protocol handler
(HTTP/HTTPS)

If all conditions are true...

Using the HTTP or HTTPS protocol

Do not require a user/password
exchange

Do not require certification details

Require a response business object from a

URL
Using the HTTP or HTTPS protocol

Do not require a user/password
exchange

Do not require certification details
Require only success or failure return

code from a URL (do not require a
response business object)

Otherwise, build a...

Custom protocol handler, See

(Chapter 4, “Building a custom protocoll

iandler,” on page 29|

Custom protocol handler See

Chapter 4, “Building a custom protocol]

Jiandler,” on page 29

XML data handler

Name Resolver (XML data

Data format is XML 1.0 See Data Handler Custom data handler See Data
Guide Handler Guide

The business object name is determined by =~ Custom name resolver See Data
using the root element name in the XML Handler Guide

document and the BOPrefix attribute in a

child meta-object for the XML Data Handler

(configurable).
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Table 8. Using a WebSphere Business Integration Server Express Adapter component or building a custom

component (continued)

Use WebSphere Business
Integration Server Express

Adapter-delivered component...  If all conditions are true... Otherwise, build a...

Entity Resolver (XML data
handler)

Custom entity resolver See Data

¢ Ignore external entities -
Handler Guide

* Search local file system for external
entities

SAX Parser (XML data handler)  Data format is XML Custom parser

Connector business object processing

The connector passes business objects between InterChange Server Express and
protocol handlers. It sends request business objects to a protocol handler and
receives response business objects from protocol handlers. However, it does not
process any of the data in the business objects.

When InterChange Server Express passes a business object to the connector, the
connector performs the following operations:

1.

Extracts the request business object from the top-level business object. The
connector expects the request business object to be the first child business
object that does not have a value of CxIgnore or CxBlank.

Sends the request business object to a protocol handler.

When the protocol handler returns the response business object, the connector
adds the response business object to the top-level business object and returns
the complete top-level business object to InterChange Server Express.

Connector business object structure

The connector requires a hierarchical business object. The top-level business object
contains attributes whose values are the destination URL string, the MIME type of
the data, the business object prefix, and the request and response business objects.

illustrates the required basic structure of a top-level business object for the
WebSphere Business Integration Server Express Adapter for XML.

Top-level business object

URL

MimeType

BOPrefix

Response
business object

Request
business object

Figure 6. Basic Structure of a top-level business object

For example, if you create two business objects, XMLApp_CustCreateRequest and
XMLApp_CustCreateResponse, then a top-level business object definition for the
connector might look like:
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XMLApp_CustCreate

URL String
MimeType String
BOPrefix String
Response XMLApp_CustCreateResponse
Request XMLApp_CustCreateRequest

Use Business Object Designer Express to create the request and response business
objects. Create the top-level business object definition, and add the required
attributes and the request and response business objects. Then configure the
connector to support the top-level business object.

Required attributes for the top-level business object

The top-level business object must have at least one attribute for the URL string,
MIME type, BOPrefix, request business object, and response business object. Each
of these attributes must be marked IsRequired = True.

describes the required attributes of a top-level business object. See the

sections that follow for more information.

Table 9. Required attributes for a top-level XML business object

Attribute Type Description

URL String Destination URL.

MimeType String MIME type to be used for the transaction.

BOPrefix String Used with the MIME type to create an instance of
the XML data handler.

Response Business object Business object that represents a response message.

See [“Request and response business objects” on|
|Eage 26I

Request Business object The business object that represents a request
message. In the top-level business object, place this
attribute after the attribute for the response
business object.

Note: The connector requires that you set at least one attribute as the key attribute.
However, the connector does not need any attributes to be set as the key.

URL

The URL string defines the destination of the data in the business object and the
protocol to use to pass the data. The string contains the entire destination,
including the protocol (such as HTTP or HTTPS); therefore, a separate attribute
that specifies the protocol is not required.

The URL string is used by the connector to open a connection to the destination
URL. When a connection is opened, the connector uses the URL string to create an
instance of the appropriate protocol handler.

For example, the string http://www.ibm.com specifies that the HTTP protocol is
being used, and an instance of the HTTP Protocol Handler is created.

MIME type

The MIME type defines the content type and format for the data that is being
passed to a URL. The connector uses the MIME type to invoke the appropriate
data handler. A meta-object identifies the data handler instance for the MIME
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type/BOPrefix combination. If the data handler implementation handles only one
MIME type, the BOPrefix attribute in a child meta-object is optional. In a top-level
business object, it is required.

The connector expects the MIME type to be text/xml by default, but you can
configure the connector to use other MIME types.

BOPrefix

The connector uses the BOPrefix with the MimeType attribute to invoke the
appropriate data handler instance. This attribute is required to guarantee the
uniqueness of a business object name. For example, you can have two Purchase
Order business objects for different applications: AppA_PO and AppB_PO.

Note: The BOPrefix attribute in a top-level business object is different from the
BOPrefix attribute in a child meta-object for the XML data handler. For more
information on XML data handler child meta-objects, see the Data Handler
Guide.

When an XML stream returns from a URL, the XML data handler maps the
root element name in the XML stream to the business object definition

BOPrefix_name. The value of the root element name is always placed after
the value of BOPrefix.

For example, if you have the root element as <Customer> in the XML
document and BOPrefix=AppA, then the BOPrefix_Name is AppA_Customer.

Request and response business objects

The request and response business objects contain the actual data to be passed to a
destination URL. When the connector receives a top-level business object, only the
request business object is populated; the response business object is populated with
the data returned from the destination URL.

Note these guidelines for defining request and response business objects in the
top-level business object:

* Place the response business object before the request business object if the
following are true:

— The request and response business objects are of the same type

— The business object is to be used for collaboration requests (only when
InterChange Server Express is the integration broker)

— The data in the request business object needs to be preserved (not overwritten
by the response from the URL)

* In the top-level business object, set the attribute value for the response business
object to CxIgnore or CxBlank. The connector passes the first non-null attribute
value to the protocol handler.

* If the business object that represents the request is identical to the business
object that represents the response, the types of the request and response
attributes should be the same.

* The request and response business objects can be different. For example, you can
send out a customer purchase order business object and receive an order status
business object.

* You can define multiple response business objects to support each response XML
document that is to be returned to the top-level business object. Multiple
response business objects enable the connector to handle the possibility that
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different types of XML documents (corresponding to different business object
types) can be returned from a Web server.

Business object conformance with data handler requirements

Although you can include any WebSphere Business Integration Server Express
Adapter business object in the top-level wrapper business object for the connector,
the contained business objects must deliver data in a form that is compliant with
the requirements of the data handler used to convert the data.

For example, for the BySize data handler, a business object definition must specify
a value for the MaxLength attribute property for each business object attribute. For
the XML data handler, the business object definition must include
application-specific information that enables the data handler to generate an XML
document.

Therefore, a good practice is to create your own business object for each type of
data to be processed. In the business object, provide only the data required by the
application and the information required by the data handler. You can then include
these business objects in the top-level connector business object.

See the Data Handler Guide for information specific to each data handler.

Business objects for event notification

The structure of an event notification business object is similar to the structure of a
request business object in that they both require attributes for a URL, MIME type,
BOPrefix, response business object, and request business object. The only difference
in business object processing is how the connector handles the contents of the
response business object. For event notification, the connector expects the response
business object to contain child business objects that represent events.

When defining an event notification business object, keep the following in mind:

* The top-level business object needs to have both a request and a response
attribute. They both need to be required, and they need to be of different types.

* Place the request business object before the response business object.

* A response business object can return multiple child business objects of the same
type. For example, you can design the response business object to return only
customer events.

* A response business object can return multiple child business objects of different
types. For example, you can design the response business object to return order
and customer events.

 All unsubscribed child business objects are archived to the archive directory.

* The business object must have the ‘DefaultVerbName” verb added to the
Supported Verb column along with the default verb in the Application-Specific
Information column of the business object definition. The default verb is the
verb to be used for event notification so that subscriptions are checked properly.
You must set the verb for each business object that is to be sent to InterChange
Server Express.

ﬂlustrates the placement of the DefaultVerbName in the Business Object
Definitions.
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Figure 7. Placement of the DefaultVerbName in the business object definitions

Business objects based on XML DTDs or schema documents

If you are creating request and response business objects based on an XML DTD or
schema document, you must create a business object definition for each type of
XML document to be processed. The business object definition contains structure
information that is contained in the XML document’s DTD or schema document.
For example, if there is one request stream (one DTD or schema document), but
four possible response stream types (four separate DTDs or schema documents),
you must define five business object definitions. On the other hand, if the request
and response stream use the same schema, you need only one business object
definition. You can use the XML Object Discovery Agent (ODA) to generate
business object definitions based on DTDs or schema documents.

Note: When reading a DTD or schema, the XML ODA ignores FIXED attributes
because the value of these attributes is optional in an XML instance, and the
value is always fixed. If you would like these FIXED values to exist in the
XML instances created from and read to business objects, you must
manually add the FIXED attributes as business object attributes. You must
check to ensure that these values are not changed at run time.

For information about how to define business object definitions for XML
documents, using either the XML ODA or manually, see the Data Handler Guide.
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Chapter 4. Building a custom protocol handler

This chapter describes the Protocol Handler Framework and how to use it to build
a custom protocol handler. It contains the following sections:

+ [“Protocol handler framework’]

» |“Creating a protocol handler class” on page 30|

» [“Protocol handler framework methods” on page 31

+ [“Custom protocol handler sample code” on page 33

Protocol handler framework

The WebSphere Business Integration Server Express Adapter Protocol Handler
Framework enables developers to write protocol handlers for different types of
protocols in a uniform manner. The Protocol Handler Framework has a class called
CWURLConnection, which contains the abstract methods that need to be
implemented to create a custom protocol handler. The framework is part of the
com.crossworlds.protocoThandler package.

Protocol handler framework classes

Every custom protocol handler must have at least two classes:
* Handler
e cw_protocol connection (cw_httpconnection for HTTP protocol)

The connection class extends the CWURLConnection class.

ﬂlustrates the hierarchy of the

com.crossworlds.connectors.utils.protocolhandler base class.
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Figure 8. Protocol handler class hierarchy

To use the Protocol Handler Framework to develop a custom protocol handler, do
the following:

¢ Create a ProtocolNameConnection Class, where ProtocolName is the name of
your protocol.

Provide at least one implementation of the getContent () method in the
connection class.

* Create a Handler class.
Handler class summary
Public URLConnection openConnection(URL url); throws IOException

Connection class summary

public String getContent (object input, String mimeType,
Sting BOPrefix) throws IOException

public String getContentType()
public synchronized void connect() throws IOException

Creating a protocol handler class

When you install the connector, stub code and makefiles for the protocol handler
are installed. The stub file contains Java code that defines an empty class that lists

all the methods you must implement. You can use the stub file as a template for
generating your custom protocol handler.

To implement your new protocol handler:
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1. Modify (and rename) the stubProtocolHandler.java file.
2. Edit the makefile to contain the name of your source file.

3. Run the makeProtocolHandler.bat file to compile the class. The makefile
compiles only the class. It does not add the class to the .jar file.

4. Add the new class to the .jar file. Use the following command:
jar cvf MyProtocolHandler.jar <classes>.
where:

¢ MyProtocolHandler.jar is the protocol handler .jar file. This file must be in
the classpath where the connector start-up batch file, start_xml.bat
(start_xml.sh for Linux), resides.

¢ <classes> are all of the classes for your protocol handler. List all classes and
separate each entry with a space.

5. Make sure that the connector can pick up the new classes. Edit the
start_xml.bat or the start_xml.sh so that the new jar file is included in the
CLASSPATH.

Protocol handler framework methods

The following section describes the Protocol Handler Framework method used
when designing a new protocol handler or modifying an existing protocol handler.

getContent ()

The getContent () method is used for business object processing. It does the

following:

e Uses the MimeType and BOPrefix business object attributes to determine the
appropriate data handler instance to create.

* Sends a business object to the appropriate data handler for conversion, and then
sends the file to a URL.

* Receives a response stream from the destination URL and invokes a data
handler instance to convert the stream into a WebSphere Business Integration
Server Express Adapter business object.

* Returns a business object back to the original caller (such as the connector).

Syntax

public String getContent (object input, String mimeType,
Sting BOPrefix) throws IOException

Parameters

input Specifies the business object interface (the business object to send)

mimeType Specifies the MIME type of the data being passed to the data
handler

BOprefix Specifies the BOPrefix of the data being passed to the data handler

Return values
Returns a business object interface

Calling the WebSphere Business Integration Server Express
Adapter-provided protocol handler

The following code example illustrates how to call the WebSphere Business
Integration Server Express Adapter-provided protocol handler.
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try

{

// set the system property, so that Java knows where to look for
// the protocol handlers. You only need to do it once.
Properties prop = System.getProperties();
prop.put("java.protocol.handler.pkgs,"
"com.crossworlds.connectors.utils.ProtocolHandlers");

URL url = new URL("http://www.crossworlds.com");
CWURLConnection uc = (CWURLConnection) url.openConnection();
BusinessObjectInterface respBO = (BusinessObjectInterface)
uc.getContent (input, mime, prefix);

}

catch (Exception XX)
{

//flag error

1
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Custom protocol handler sample code

The following sample code can be used as a guide when developing a custom
protocol handler.
[x%

* This package hierarchy is used to write the Protocol Handler.

* [ProtocolName] should be substituted with the name of the protocol

* for which the handler is being written.

* For example com.crossworlds.connectors.utils.ProtocolHandlers.ftp

or com.crossworlds.connectors.utils.ProtocolHandlers.http
*
/

package com.crossworlds.connectors.utils.ProtocolHandlers.[ProtocolName] ;

import CxCommon.BusinessObjectInterface;
import com.crossworlds.connectors.utils.ProtocolHandlers.CWURLConnection;
import com.crossworlds.DataHandlers.DataHandler;

import AppSide_Connector.JavaConnectorUtil;

import java.net.=;
import java.io.*;

[**

* The handler class creates a ProtocolNameConnection class instance
%= It is invoked indirectly via Java's URL getContent() mechanism.

*

* how to use it:

* System.setProperty ("java.protocol.handler.pkgs",
="com.crossworlds.ProtocolHandler");
*URL url = new URL ("the URL");
*CWURLConnection uc = (CWURLConnection) url.openConnection ();
* /
public class Handler
{
// this will return the appropriate URLConnection
// But the constructor takes only one argument - the URL. As this
// is called by Java Networking Framework.
public URLConnection openConnection(URL url) throws IOException
{
// you can pass in any parameters here.
return new MyURLConnection (url);
}
}

class MyURLConnection extends CWURLConnection {

[**

% This is instantiated by URL.openConnection()
*/

public MyURLConnection(URL url)

// store this URL some where

}

[x*

* This method returns the content type of the data
*/

public String getContentType()

{

// here is where you have to determine the content Type (aka
// Mimetype) of URL streams
1

[**
* This method is used to create a connection
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*/
pub
{

1
[**

*

*
*

*
*
*
*
*
*

*/
pub
Sting
{

// rem
/] dif
// pro
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lic synchronized void connect() throws IOException

// you might call super().connect as it suffices most of the
// time.
// If it is custom protocol, do the handshaking stuff here

getContent () : The getContent method used by CrossWorlds.
This method takes in 3 parameters
- input Object,
- content type for the data &
- Business Object Prefix to * be used to create the Business
Object name
It returns an appropriate Object back to the caller. This
method interacts with the DataHandler using the exposed APIs
for the DataHandler.

lic String getContent (object input, String mimeType,
BOPrefix) throws IOException

// log a message
JavaConnectorUtil.logMessage
("Togging a message", JavaConnectorUtil.XRD_INFO);

// write a trace

if (JavaConnectorUtil.isTraceEnabled (JavaConnectorUtil.LEVEL3))
JavaConnectorUtil.traceWrite (JavaConnectorUtil.LEVEL3,
"Level 3 trace msg");

// get a datahandler
DataHandler dh = DataHandler.createHandler (null, mimeType, BOprefix);

InputStream in = dh.getStreamFromB0
( (BusinessObjectInterface) input, null);

// Send this to URL
- read data from Input Stream
- write to URL
- repeat until input stream is drained.

// Now read the response
String replyString = // some how read the reply from URL
String outputType = // get the mime of reply some how

ember to get a fresh DH, as the incoming data may be of
ferent mime type than was originally received by the
tocol handler

DataHandler dh2 = DataHandler.createHandler

(null, outputType, BOprefix);

BusinessObjectInterface replyBO = dh2.getBO
(replyString, outputType);

return replyBO; // DONE!



Appendix A. Standard configuration properties

This appendix describes the standard configuration properties for the connector
component of the adapters in WebSphere Business Integration Server Express,
running on WebSphere InterChange Server Express.

Not every connector makes use of all these standard properties. When you select
an integration broker from Connector Configurator Express, you will see a list of
the standard properties that you need to configure for your adapter.

For information about properties specific to the connector, see the relevant adapter
user guide.

Configuring standard connector properties

Adapter connectors have two types of configuration properties:
¢ Standard configuration properties
 Connector-specific configuration properties

This section describes the standard configuration properties. For information on
configuration properties specific to a connector, see its adapter user guide.

Using Connector Configurator Express

You configure connector properties from Connector Configurator Express, which
you access from System Manager. For more information on using Connector
Configurator Express, refer to the Connector Configurator Express appendix.

Setting and updating property values
The default length of a property field is 255 characters.

The connector uses the following order to determine a property’s value (where the
highest number overrides other values):

1. Default

2. Repository

3. Local configuration file
4. Command line

A connector obtains its configuration values at startup. If you change the value of
one or more connector properties during a run-time session, the property’s Update
Method determines how the change takes effect. There are four different update
methods for standard connector properties:
* Dynamic
The change takes effect immediately after it is saved in System Manager.
* Component restart
The change takes effect only after the connector is stopped and then restarted in
System Manager. You do not need to stop and restart the application-specific
component or the integration broker.
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* Server restart
The change takes effect only after you stop and restart the application-specific
component and the integration broker.

* Agent restart
The change takes effect only after you stop and restart the application-specific
component.

To determine how a specific property is updated, refer to the Update Method
column in the Connector Configurator Express window, or see the Update Method
column in the Property Summary table below.

Summary of standard properties

provides a quick reference to the standard connector configuration
properties. Not all the connectors make use of all these properties, and property
settings may differ from integration broker to integration broker, as standard
property dependencies are based on RepositoryDirectory.

You must set the values of some of these properties before running the connector.
See the following section for an explanation of each property.

Table 10. Summary of standard configuration properties

Update
Property name Possible values Default value method Notes
IAdminIng gueugl Valid JMS queue name CONNECTORNAME /ADMININQUEUE Component | Delivery
restart Transport is
JMS
AdminOutQueue) Valid JMS queue name CONNECTORNAME/ADMINOUTQUEUE [ Component | Delivery
restart Transport is
MS
1-4 1 Component | Delivery
restart Transport is
IDL
0-5 0 Dynamic
Application name Value specified for the Component
connector application name restart
BrokerType 1Cs ICS
|CharacterEncoding] ascii7, ascii8, SJIS, ascii7 Component
Cp949, GBK, Big5h, restart
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437
Note: This is a subset
of supported
values.
|ConcurrentEventTriggeredFlowsd 1 to 32,767 1 Component | Repository
restart directory
is
<REMOTE>
|ContainerManagedEvents| No value or JMS No value Component | Delivery
restart Transport is
MS
|ControllerStoreAndForwardModed | true or false truetrue Dynamic Repository
directory
is
<REMOTE>
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Table 10. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
|ControllerTraceLevel| 0-5 0 Dynamic Repository
directory
is
<REMOTE>
CONNECTORNAME/DELIVERYQUEUE | Component |JMS transport
| restart only
|DelivervTranspora IDL or JMS DL Component
restart
|DuplicateEventElimination true or false false Component | JMS transport
restart only: Container
Managed Events
must be
<NONE>
|[EnableOidForFlowMonitoring] true or false false Component
restart
|Fault£ 2ueug| CONNECTORNAME / FAULTQUEUE Component | JMS
restart transport
only
hms.FactoryClassNamd CxCommon.Messaging.jms | CxCommon.Messaging. Component | JMS transport
. IBMMQSeriesFactory jms.IBMMQSeriesFactory restart only
or any Java class name
hms.MessageBrokerNamd crossworlds.queue. crossworlds.queue.manager Component | JMS transport
manager restart only
|jmslNumConcurrentRequestS| Positive integer 10 Component | JMS transport
restart only
Any valid password Component | JMS transport
restart only
Any valid name Component | JMS transport
restart only
[]vm MaxHeapSize| Heap size in megabytes 128m Component | Repository
restart directory
is
<REMOTE>
lvmMaxNativeStackSize| Size of stack in kilobytes | 128k Component | Repository
restart directory
is
<REMOTE>
lvmMinHeapSize| Heap size in megabytes Im Component | Repository
restart directory
is
<REMOTE>
ILocald] en_US, ja_JP, ko KR, en_US Component
zh_CN, zh_TW, fr_FR, restart
de_DE,
it_IT, es_ES, pt_BR
Note: This is a
subset of the
supported
locales.
|Log AtInterchangeEnd| true or false false Component
restart
[IMaxEventCapacity| 1-2147483647 2147483647 Dynamic Repository
Directory is
<REMOTE>
||MessageFileNamg| Path or filename InterchangeSystem.txt Component
restart
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Table 10. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
Any valid queue name | CONNECTORNAME/MONITORQUEUE | Component |JMS transport
restart only:
DuplicateEvent
Elimination
must be true
[OADAutoRestartAgent| true or false false Dynamic Repository
Directory is
<REMOTE>
|OADMaxNumRetry| A positive number 1000 Dynamic Repository
Directory is
<REMOTE>
|OADRetryTimelntervall A positive number in 10 Dynamic Repository
minutes Directory is
<REMOTE>
IPollEndTimgI HH:MM HH:MM Component
(HH is 0-23, MM is 0-59) restart
[PollFrequency] A positive integer in 10000 Dynamic
milliseconds
no (to disable polling)
key (to poll only when
the letter p is entered in
the connector’s
Command Prompt
window)
PollQuanti 1-500 1 Agent JMS transport
restart only:
Container
Managed
Events is
specified
PollStartTime HH:MM(HH is 0-23, MM is | HH:MM Component
0-59) restart
Location of metadata Agent Set to
repository restart <REMOTE>
Valid JMS queue name CONNECTORNAME /REQUESTQUEUE Component | Delivery
restart Transport is
JMS
[ResponseQueud Valid JMS queue name CONNECTORNAME/RESPONSEQUEUE | Component | Delivery
restart Transport is
JMS:
[RestartRetryCount| 0-99 3 Dynamic
A sensible positive 1 Dynamic
value in minutes:
1 - 2147483547
ISourceQueuel Valid JMS queue name | CONNECTORNAME/SOURCEQUEUE Agent Only if
restart Delivery
Transport is
JMS and
Container
Managed
Events is
specified
[SynchronousRequestQueue| Valid JMS queue name | CONNECTORNAME/ Component | Delivery
SYNCHRONOUSREQUESTQUEUE restart Transport is

TMS
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Table 10. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
|SynchronousRequestTimeout| 0 - any number (millisecs) | 0 Component | Delivery
restart Transport is
JMS
|SynchronousResponseQueud Valid JMS queue name CONNECTORNAME/ Component | Delivery
SYNCHRONOUSRESPONSEQUEUE restart Transport is
JMS
CwBO CwBO Agent
restart

Standard configuration properties

This section lists and defines each of the standard connector configuration
properties.

AdmininQueue

The queue that is used by the integration broker to send administrative messages
to the connector.

The default value is CONNECTORNAME /ADMININQUEUE.

AdminOutQueue

The queue that is used by the connector to send administrative messages to the
integration broker.

The default value is CONNECTORNAME /ADMINOUTQUEUE.

AgentConnections

The AgentConnections property controls the number of ORB connections opened
by orb.init[].

By default, the value of this property is set to 1. There is no need to change this
default.

AgentTracelLevel

Level of trace messages for the application-specific component. The default is 0.
The connector delivers all trace messages applicable at the tracing level set or
lower.

ApplicationName

Name that uniquely identifies the connector’s application. This name is used by
the system administrator to monitor the WebSphere business integration system
environment. This property must have a value before you can run the connector.

BrokerType

Identifies the integration broker that you are using, which is ICS.

CharacterEncoding

Specifies the character code set used to map from a character (such as a letter of
the alphabet, a numeric representation, or a punctuation mark) to a numeric value.
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Note: Java-based connectors do not use this property. A C++ connector currently
uses the value ascii7 for this property.

By default, a subset of supported character encodings only is displayed in the drop
list. To add other supported values to the drop list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory. For more information,
see the appendix on using Connector Configurator Express in this guide.

ConcurrentEventTriggeredFlows

Determines how many business objects can be concurrently processed by the
connector for event delivery. Set the value of this attribute to the number of
business objects you want concurrently mapped and delivered. For example, set
the value of this property to 5 to cause five business objects to be concurrently
processed. The default value is 1.

Setting this property to a value greater than 1 allows a connector for a source
application to map multiple event business objects at the same time and deliver
them to multiple collaboration instances simultaneously. This speeds delivery of
business objects to the integration broker, particularly if the business objects use
complex maps. Increasing the arrival rate of business objects to collaborations can
improve overall performance in the system.

To implement concurrent processing for an entire flow (from a source application
to a destination application), you must:

* Configure the collaboration to use multiple threads by setting its Maximum number
of concurrent events property high enough to use multiple threads.

* Ensure that the destination application’s application-specific component can
process requests concurrently. That is, it must be multi-threaded, or be able to
use connector agent parallelism and be configured for multiple processes. Set the
Parallel Process Degree configuration property to a value greater than 1.

The ConcurrentEventTriggeredFlows property has no effect on connector polling,
which is single-threaded and performed serially.

ContainerManagedEvents

This property allows a JMS-enabled connector with a JMS event store to provide
guaranteed event delivery, in which an event is removed from the source queue
and placed on the destination queue as a single JMS transaction.

This property only appears if the DeliveryTransport property is set to the value
JMS.

The default value is No value.

When ContainerManagedEvents is set to JMS, you must configure the following
properties to enable guaranteed event delivery:

* PollQuantity = 1 to 500
* SourceQueue = CONNECTORNAME/SOURCEQUEUE

You must also configure a data handler with the MimeType, DHClass, and
DataHandlerConfigMOName (optional) properties. To set those values, use the
Data Handler tab in Connector Configurator Express. The fields for the values
under the Data Handler tab will be displayed only if you have set
ContainerManagedEvents to JMS.
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Note: When ContainerManagedEvents is set to JMS, the connector does not call its
pol1ForEvents() method, thereby disabling that method’s functionality.

ControllerStoreAndForwardMode

Sets the behavior of the connector controller after it detects that the destination
application-specific component is unavailable.

If this property is set to true and the destination application-specific component is
unavailable when an event reaches ICS, the connector controller blocks the request
to the application-specific component. When the application-specific component
becomes operational, the controller forwards the request to it.

However, if the destination application’s application-specific component becomes
unavailable after the connector controller forwards a service call request to it, the
connector controller fails the request.

If this property is set to false, the connector controller begins failing all service
call requests as soon as it detects that the destination application-specific
component is unavailable.

The default is true.

ControllerTraceLevel
Level of trace messages for the connector controller. The default is 0.

DeliveryQueue
Applicable only if DeliveryTransport is JMS.

The queue that is used by the connector to send business objects to the WebSphere
InterChange Server Express.

The default value is CONNECTORNAME/DELIVERYQUEUE.

DeliveryTransport

Specifies the transport mechanism for the delivery of events. Possible values are
IDL for CORBA IIOP or JMS for Java Messaging Service. The default is IDL.

The connector sends service call requests and administrative messages over
CORBA IIOP if the value configured for the DeliveryTransport property is IDL.

JMS

Enables communication between the connector and client connector framework
using Java Messaging Service (JMS).

If you select JMS as the delivery transport, additional JMS properties such as
Jjms .MessageBrokerName, jms.FactoryClassName, jms.Password, and jms.UserName,
appear in Connector Configurator Express. The first two of these properties are
required for this transport.

Important: There may be a memory limitation if you use the JMS transport

mechanism for a connector running on WebSphere InterChange Server
Express.
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In this environment, you may experience difficulty starting both the connector
controller (on the server side) and the connector (on the client side) due to memory
use within the WebSphere MQ client.

DuplicateEventElimination

When you set this property to true, a JMS-enabled connector can ensure that
duplicate events are not delivered to the delivery queue. To use this feature, the
connector must have a unique event identifier set as the business object’s
ObjectEventld attribute in the application-specific code. This is done during
connector development.

This property can also be set to false.

Note: When DuplicateEventElimination is set to true, you must also configure
the MonitorQueue property to enable guaranteed event delivery.

EnableOidForFlowMonitoring

When you set this property to true, the adapter framework will mark the
incoming ObjectEventld as a foreign key for the purpose of flow monitoring.

The default is false.

FaultQueue

If the connector experiences an error while processing a message then the
connector moves the message to the queue specified in this property, along with a
status indicator and a description of the problem.

The default value is CONNECTORNAME/FAULTQUEUE.

JvmMaxHeapSize
The maximum heap size for the agent (in megabytes).

The default value is 128m.

JvmMaxNativeStackSize

The maximum native stack size for the agent (in kilobytes).

The default value is 128k.

JvmMinHeapSize

The minimum heap size for the agent (in megabytes).

The default value is 1m.

jms.FactoryClassName

Specifies the class name to instantiate for a JMS provider. You must set this
connector property when you choose JMS as your delivery transport mechanism
(DeliveryTransport).

The default is CxCommon.Messaging.jms.IBMMQSeriesFactory.
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jms.MessageBrokerName

Specifies the broker name to use for the JMS provider. You must set this connector
property when you choose JMS as your delivery transport mechanism (see
DeliveryTransport).

The default is crossworlds.queue.manager.

jms.NumConcurrentRequests

Specifies the maximum number of concurrent service call requests that can be sent
to a connector at the same time. Once that maximum is reached, new service calls
block and wait for another request to complete before proceeding.

The default value is 10.

jms.Password
Specifies the password for the JMS provider. A value for this property is optional.

There is no default.

jms.UserName
Specifies the user name for the JMS provider. A value for this property is optional.

There is no default.

Locale

Specifies the language code, country or territory, and, optionally, the associated
character code set. The value of this property determines such cultural conventions
as collation and sort order of data, date and time formats, and the symbols used in
monetary specifications.

A locale name has the following format:
Ul _TT.codeset

where:

ll a two-character language code (usually in lower
case)

T a two-letter country or territory code (usually in
upper case)

codeset the name of the associated character code set; this

portion of the name is often optional.

By default, only a subset of supported locales appears in the drop list. To add
other supported values to the drop list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory. For more information,
see the appendix on using Connector Configurator Express in this guide.

The default value is en_US. If the connector has not been globalized, the only valid
value for this property is en_US. To determine whether a specific connector has

been globalized, see the connector version list on these websites:

http:/ /www.ibm.com/software/websphere/wbiadapters/infocenter, or
http:/ /www.ibm.com /websphere/integration/wicserver/infocenter
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LogAtinterchangeEnd

Specifies whether to log errors to the integration broker’s log destination. Logging
to the broker’s log destination also turns on e-mail notification, which generates
e-mail messages for the MESSAGE_RECIPIENT specified in the InterchangeSystem.cfg
file when errors or fatal errors occur.

For example, when a connector loses its connection to its application, if
LogAtInterChangeEnd is set to true, an e-mail message is sent to the specified
message recipient. The default is false.

MaxEventCapacity

The maximum number of events in the controller buffer. This property is used by
flow control.

The value can be a positive integer between 1 and 2147483647. The default value is
2147483647.

MessageFileName

The name of the connector message file. The standard location for the message file
is \connectors\messages. Specify the message filename in an absolute path if the
message file is not located in the standard location.

If a connector message file does not exist, the connector uses
InterchangeSystem.txt as the message file. This file is located in the product
directory.

Note: To determine whether a specific connector has its own message file, see the
individual adapter user guide.

MonitorQueue

The logical queue that the connector uses to monitor duplicate events. It is used
only if the DeliveryTransport property value is J]MS and
DupTicateEventETimination is set to TRUE.

The default value is CONNECTORNAME /MONITORQUEUE

OADAutoRestartAgent

Specifies whether the connector uses the automatic and remote restart feature. This
feature uses the MQ-triggered Object Activation Daemon (OAD) to restart the
connector after an abnormal shutdown, or to start a remote connector from System
Monitor.

This property must be set to true to enable the automatic and remote restart
feature. For information on how to configure the MQ-triggered OAD feature, see
the Installation Guide for Windows.

The default value is false.

OADMaxNumRetry

Specifies the maximum number of times that the MQ-triggered OAD automatically
attempts to restart the connector after an abnormal shutdown. The
OADAutoRestartAgent property must be set to true for this property to take effect.
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The default value is 1000.

OADRetryTimelnterval

Specifies the number of minutes in the retry-time interval for the MQ-triggered
OAD. If the connector agent does not restart within this retry-time interval, the
connector controller asks the OAD to restart the connector agent again. The OAD
repeats this retry process as many times as specified by the OADMaxNumRetry
property. The OADAutoRestartAgent property must be set to true for this property
to take effect.

The default is 10.

PollIEndTime

Time to stop polling the event queue. The format is HH:MM, where HH represents
0-23 hours, and MM represents 0-59 seconds.

You must provide a valid value for this property. The default value is HH:MM, but
must be changed.

PollFrequency

The amount of time between polling actions. Set Po11Frequency to one of the
following values:

* The number of milliseconds between polling actions.

* The word key, which causes the connector to poll only when you type the letter
p in the connector’'s Command Prompt window. Enter the word in lowercase.

* The word no, which causes the connector not to poll. Enter the word in
lowercase.

The default is 10000.

Important: Some connectors have restrictions on the use of this property. To
determine whether a specific connector does, see the installing and
configuring chapter of its adapter guide.

PollQuantity

Designates the number of items from the application that the connector should poll
for. If the adapter has a connector-specific property for setting the poll quantity, the
value set in the connector-specific property will override the standard property
value.

PollStartTime

The time to start polling the event queue. The format is HH: MM, where HH represents
0-23 hours, and MM represents 0-59 seconds.

You must provide a valid value for this property. The default value is HH:MM, but
must be changed.

RequestQueue

The queue that is used by WebSphere InterChange Server Express to send business
objects to the connector.

The default value is CONNECTOR/REQUESTQUEUE.
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RepositoryDirectory

The location of the repository from which the connector reads the XML schema
documents that store the meta-data for business object definitions.

This value must be set to <REMOTE> because the connector obtains this
information from the InterChange Server Express repository.

ResponseQueue
Applicable only if DeTiveryTransport is JMS.

Designates the JMS response queue, which delivers a response message from the
connector framework to the integration broker. WebSphere InterChange Server
Express sends the request and waits for a response message in the JMS response
queue.

RestartRetryCount

Specifies the number of times the connector attempts to restart itself. When used
for a parallel connector, specifies the number of times the master connector
application-specific component attempts to restart the slave connector
application-specific component.

The default is 3.

RestartRetryinterval

Specifies the interval in minutes at which the connector attempts to restart itself.
When used for a parallel connector, specifies the interval at which the master
connector application-specific component attempts to restart the slave connector
application-specific component. Possible values ranges from 1 to 2147483647.

The default is 1.

SourceQueue

Applicable only if DeliveryTransport is JMS and ContainerManagedEvents is
specified.

Designates the JMS source queue for the connector framework in support of
guaranteed event delivery for JMS-enabled connectors that use a JMS event store.
For further information, see [’ContainerManagedEvents” on page 40|

The default value is CONNECTOR/SOURCEQUEUE.

SynchronousRequestQueue
Applicable only if DeliveryTransport is JMS.

Delivers request messages that require a synchronous response from the connector
framework to the broker. This queue is necessary only if the connector uses
synchronous execution. With synchronous execution, the connector framework
sends a message to the SynchronousRequestQueue and waits for a response back
from the broker on the SynchronousResponseQueue. The response message sent to
the connector bears a correlation ID that matches the ID of the original message.

The default is CONNECTORNAME/SYNCHRONOUSREQUESTQUEUE
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SynchronousResponseQueue
Applicable only if DeliveryTransport is JMS.

Delivers response messages sent in reply to a synchronous request from the broker
to the connector framework. This queue is necessary only if the connector uses
synchronous execution.

The default is CONNECTORNAME/SYNCHRONOUSRESPONSEQUEUE

SynchronousRequestTimeout
Applicable only if DeTiveryTransport is JMS.
Specifies the time in minutes that the connector waits for a response to a
synchronous request. If the response is not received within the specified time, then
the connector moves the original synchronous request message into the fault queue

along with an error message.

The default value is 0.

WireFormat

This is the message format on the transport. The setting isCwBO0.
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Appendix B. Connector Configurator Express

This appendix describes how to use Connector Configurator Express to set
configuration property values for your adapter.

The topics covered in this appendix are:

+ [“Overview of Connector Configurator Express” on page 49|

* [“Starting Connector Configurator Express” on page 50

« |“Creating a connector-specific property template” on page 50|

* |“Creating a new configuration file” on page 53

* |[“Setting the configuration file properties” on page 55|

» [“Using Connector Configurator Express in a globalized environment” on page|

60

Overview of Connector Configurator Express

Connector Configurator Express allows you to configure the connector component
of your adapter for use with WebSphere InterChange Server Express.

You use Connector Configurator Express to:
* Create a connector-specific property template for configuring your connector.

* Create a connector configuration file; you must create one configuration file for
each connector you install.

* Set properties in a configuration file.
You may need to modify the default values that are set for properties in the
connector templates. You must also designate supported business object
definitions and maps for use with collaborations as well as specify messaging,
logging and tracing, and data handler parameters, as required.

Connector configuration properties include both standard configuration properties
(the properties that all connectors have) and connector-specific properties
(properties that are needed by the connector for a specific application or
technology).

Because standard properties are used by all connectors, you do not need to define
those properties from scratch; Connector Configurator Express incorporates them
into your configuration file as soon as you create the file. However, you do need to
set the value of each standard property in Connector Configurator Express.

The range of standard properties may not be the same for all brokers and all
configurations. Some properties are available only if other properties are given a
specific value. The Standard Properties window in Connector Configurator Express
will show the properties available for your particular configuration.

For connector-specific properties, however, you need first to define the properties
and then set their values. You do this by creating a connector-specific property
template for your particular adapter. There may already be a template set up in
your system, in which case, you simply use that. If not, follow the steps in
[“Creating a new template” on page 51 to set up a new one.
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Note: Connector Configurator Express runs only in a Windows environment. If
you are running the connector in another environment, use Connector
Configurator Express in Windows to modify the configuration file and then
copy the file to the other environment.

Starting Connector Configurator Express

You can start and run Connector Configurator Express in either of two modes:
* Independently, in stand-alone mode
e From System Manager

Running Configurator Express in stand-alone mode

You can run Connector Configurator Express independently and work with
connector configuration files, irrespective of your broker.

To do so:

* From Start>Programs, click IBM WebSphere Business Integration Server
Express> Toolset Express>Development>Connector Configurator Express.

* Select File>New>Configuration File.

You may choose to run Connector Configurator Express independently to generate
the file, and then connect to System Manager to save it in a System Manager
project (see[“Completing a configuration file” on page 55|)

Running Configurator Express from System Manager

You can run Connector Configurator Express from System Manager.

To run Connector Configurator Express:
1. Open the System Manager.

2. In the System Manager window, expand the Integration Component Libraries
icon and highlight Connectors.

3. From the System Manager menu bar, click Tools>Connector Configurator
Express. The Connector Configurator Express window opens and displays a
New Connector dialog box.

To edit an existing configuration file:

1. In the System Manager window, select any of the configuration files listed in
the Connector folder and right-click on it.

2. Click the Standard Properties tab to see which properties are included in this
configuration file.

Creating a connector-specific property template

To create a configuration file for your connector, you need a connector-specific
property template as well as the system-supplied standard properties.

You can create a brand-new template for the connector-specific properties of your
connector, or you can use an existing file as the template.

+ To create a new template, see [‘Creating a new template” on page 51|

* To use an existing file, simply modify an existing template and save it under the
new name.
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Creating a new template

This section describes how you create properties in the template, define general
characteristics and values for those properties, and specify any dependencies
between the properties. Then you save the template and use it as the base for
creating a new connector configuration file.

To create a template:

1.
2.

Click File>New>Connector-Specific Property Template.

The Connector-Specific Property Template dialog box appears, with the
following fields:

Template, and Name

Enter a unique name that identifies the connector, or type of connector, for
which this template will be used. You will see this name again when you
open the dialog box for creating a new configuration file from a template.

Old Template, and Select the Existing Template to Modify

The names of all currently available templates are displayed in the Template
Name display.

To see the connector-specific property definitions in any template, select that
template’s name in the Template Name display. A list of the property
definitions contained in that template will appear in the Template Preview
display. You can use an existing template whose property definitions are
similar to those required by your connector as a starting point for your
template.

Select a template from the Template Name display, enter that template name in
the Find Name field (or highlight your selection in Template Name), and click
Next.

If you do not see any template that displays the connector-specific properties used
by your connector, you will need to create one.

Specifying general characteristics

When you click Next to select a template, the Properties - Connector-Specific
Property Template dialog box appears. The dialog box has tabs for General
characteristics of the defined properties and for Value restrictions. The General
display has the following fields:

* General:
Property Type
Updated Method
Description

* Flags
Standard flags

* Custom Flag
Flag

After you have made selections for the general characteristics of the property, click

the Value tab.

Specifying values

The Value tab enables you to set the maximum length, the maximum multiple
values, a default value, or a value range for the property. It also allows editable
values. To do so:

1.

Click the Value tab. The display panel for Value replaces the display panel for
General.
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n

Select the name of the property in the Edit properties display.

In the fields for Max Length and Max Multiple Values, make any changes. The
changes will not be accepted unless you also open the Property Value dialog
box for the property, described in the next step.

Right-click the box in the top left-hand corner of the value table and click Add.
A Property Value dialog box appears. Depending on the property type, the
dialog box allows you to enter either a value, or both a value and range. Enter
the appropriate value or range, and click OK.

The Value panel refreshes to display any changes you made in Max Length
and Max Multiple Values. It displays a table with three columns:

The Value column shows the value that you entered in the Property Value
dialog box, and any previous values that you created.

The Default Value column allows you to designate any of the values as the
default.

The Value Range shows the range that you entered in the Property Value
dialog box.

After a value has been created and appears in the grid, it can be edited from
within the table display. To make a change in an existing value in the table,
select an entire row by clicking on the row number. Then right-click in the
Value field and click Edit Value.

Setting dependencies
When you have made your changes to the General and Value tabs, click Next. The
Dependencies - Connector-Specific Property Template dialog box appears.

A dependent property is a property that is included in the template and used in
the configuration file only if the value of another property meets a specific
condition. For example, Po11Quantity appears in the template only if JMS is the
transport mechanism and DuplicateEventElimination is set to True.

To designate a property as dependent and to set the condition upon which it
depends, do this:

1.

In the Available Properties display, select the property that will be made
dependent.

In the Select Property field, use the drop-down menu to select the property
that will hold the conditional value.

In the Condition Operator field, select one of the following:
== (equal to)

!= (not equal to)

> (greater than)

< (less than)

>= (greater than or equal to)

<=(less than or equal to)

In the Conditional Value field, enter the value that is required in order for the
dependent property to be included in the template.

With the dependent property highlighted in the Available Properties display,
click an arrow to move it to the Dependent Property display.

Click Finish. Connector Configurator Express stores the information you have
entered as an XML document, under \data\app in the\bin directory where you
have installed Connector Configurator Express.
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Creating a new configuration file

You create a connector configuration file from a connector-specific template or by
modifying an existing configuration file.

Creating a configuration file from a connector-specific
template

Once a connector-specific template has been created, you can use it to create a
configuration file:

1. Click File>New>Connector Configuration.
2. The New Connector dialog box appears, with the following fields:
* Name

Enter the name of the connector. Names are case-sensitive. The name you
enter must be unique, and must be consistent with the file name for a
connector that is installed on the system.

Important: Connector Configurator Express does not check the spelling of
the name that you enter. You must ensure that the name is
correct.

* System Connectivity
The default broker is ICS. You cannot change this value.
* Select Connector-Specific Property Template

Type the name of the template that has been designed for your connector.
The available templates are shown in the Template Name display. When you
select a name in the Template Name display, the Property Template Preview
display shows the connector-specific properties that have been defined in
that template.

Select the template you want to use and click OK.

3. A configuration screen appears for the connector that you are configuring. The
title bar shows the integration broker and connector names. You can fill in all
the field values to complete the definition now, or you can save the file and
complete the fields later.

4. To save the file, click File>Save>To File or File>Save>To Project. To save to a
project, System Manager must be running.
If you save as a file, the Save File Connector dialog box appears. Choose *.cfg
as the file type, verify in the File Name field that the name is spelled correctly
and has the correct case, navigate to the directory where you want to locate the
file, and click Save. The status display in the message panel of Connector
Configurator Express indicates that the configuration file was successfully
created.

Important: The directory path and name that you establish here must match
the connector configuration file path and name that you supply in
the startup file for the connector.

5. To complete the connector definition, enter values in the fields for each of the
tabs of the Connector Configurator Express window, as described later in this
chapter.
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Using an existing file

To use an existing file to configure a connector, you must open the file in
Connector Configurator Express, revise the configuration, and then save the file as
a configuration file (*.cfg).

You may have an existing file available in one or more of the following formats:

* A connector definition file.
This is a text file that lists properties and applicable default values for a specific
connector. Some connectors include such a file in a \repository directory in
their delivery package (the file typically has the extension .txt; for example,
CN_XML.txt for the XML connector).

* An InterChange Server Express repository file.
Definitions used in a previous InterChange Server Express implementation of
the connector may be available to you in a repository file that was used in the
configuration of that connector. Such a file typically has the extension .in or
.out.

* A previous configuration file for the connector.
Such a file typically has the extension *.cfg.

Although any of these file sources may contain most or all of the connector-specific
properties for your connector, the connector configuration file will not be complete
until you have opened the file and set properties, as described later in this chapter.

To use an existing file to configure a connector, you must open the file in
Connector Configurator Express, revise the configuration, and then resave the file.

Follow these steps to open a *.txt, *x.cfg or *.in file from a directory:
1. In Connector Configurator Express, click File>Open>From File.

2. In the Open File Connector dialog box, select one of the following file types to
see the available files:

* Configuration (x.cfg)
* InterChange Server Express Repository (*.1in, *.out)

Choose this option if a repository file was used to configure the connector. A
repository file may include multiple connector definitions, all of which will
appear when you open the file.

o All files (*.*)

Choose this option if a *.txt file was delivered in the adapter package for
the connector, or if a definition file is available under another extension.

3. In the directory display, navigate to the appropriate connector definition file,
select it, and click Open.

Follow these steps to open a connector configuration from a System Manager

project:

1. Start System Manager. A configuration can be opened from or saved to System
Manager only if System Manager has been started.

2. Start Connector Configurator Express.

3. Click File>Open>From Project.
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Completing a configuration file

When you open a configuration file or a connector from a project, the Connector
Configurator Express window displays the configuration screen, with the current
attributes and values.

Connector Configurator Express requires values for properties described in the
following sections:

* [“Setting standard connector properties”|

» |“Setting application-specific configuration properties” on page 56

* [“Specifying supported business object definitions” on page 57

* [“Associated maps” on page 58

« |“Setting trace/log file values” on page 59

Note: For connectors that use JMS messaging, an additional category may display,
for special configuration of data handlers that convert the data to business
objects. For further information, see [“Data handlers” on page 60

Setting the configuration file properties

When you create and name a new connector configuration file, or when you open
an existing connector configuration file, Connector Configurator Express displays a
configuration screen with tabs for the categories of required configuration values.

Standard properties differ from connector-specific properties as follows:

 Standard properties of a connector are shared by both the application-specific
component of a connector and its broker component. All connectors have the
same set of standard properties. These properties are described in Appendix A of
each adapter guide. You can change some but not all of these values.

* Application-specific properties apply only to the application-specific component
of a connector, that is, the component that interacts directly with the application.
Each connector has application-specific properties that are unique to its
application. Some of these properties provide default values and some do not;
you can modify some of the default values. The installation and configuration
chapters of each adapter guide describe the application-specific properties and
the recommended values.

The fields for Standard Properties and Connector-Specific Properties are
color-coded to show which are configurable:

A field with a grey background indicates a standard property. You can change
the value but cannot change the name or remove the property.

A field with a white background indicates an application-specific property. These
properties vary according to the specific needs of the application or connector.
You can change the value and delete these properties.

* You can configure Value fields.

e The Update Method displayed for each property indicates whether a component
or agent restart is necessary to activate changed values.

Setting standard connector properties
To change the value of a standard property:
1. Click in the field whose value you want to set.
2. Either enter a value, or select one from the drop-down menu if it appears.
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3. After entering all the values for the standard properties, you can do one of the
following;:

* To discard the changes, preserve the original values, and exit Connector
Configurator Express, click File>Exit (or close the window), and click No
when prompted to save changes.

* To enter values for other categories in Connector Configurator Express, select
the tab for the category. The values you enter for Standard Properties (or
any other category) are retained when you move to the next category. When
you close the window, you are prompted to either save or discard the values
that you entered in all the categories as a whole.

* To save the revised values, click File>Exit (or close the window) and click
Yes when prompted to save changes. Alternatively, click Save>To File from
either the File menu or the toolbar.

Setting application-specific configuration properties
For application-specific configuration properties, you can add or change property

names, configure values, delete a property, and encrypt a property. The default
property length is 255 characters.

1. Right-click in the top left portion of the grid. A pop-up menu bar will appear.
Click Add to add a property. To add a child property, right-click on the parent
row number and click Add child.

2. Enter a value for the property or child property.
3. To encrypt a property, select the Encrypt box.

4. Choose to save or discard changes, as described for [“Setting standard connector]
[properties” on page 55.|

The Update Method displayed for each property indicates whether a component or
agent restart is necessary to activate changed values.

Important: Changing a preset application-specific connector property name may
cause a connector to fail. Certain property names may be needed by
the connector to connect to an application or to run properly.

Encryption for connector properties

Application-specific properties can be encrypted by selecting the Encrypt check
box in the Edit Property window. To decrypt a value, click to clear the Encrypt
check box, enter the correct value in the Verification dialog box, and click OK. If
the entered value is correct, the value is decrypted and displays.

The adapter user guide for each connector contains a list and description of each
property and its default value.

If a property has multiple values, the Encrypt check box will appear for the first
value of the property. When you select Encrypt, all values of the property will be
encrypted. To decrypt multiple values of a property, click to clear the Encrypt
check box for the first value of the property, and then enter the new value in the
Verification dialog box. If the input value is a match, all multiple values will
decrypt.

Update method

Refer to the descriptions of update methods found in the Standard configuration
properties for connectors appendix, under [’Setting and updating property values” on|
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Connector properties are almost all static and the Update Method is Component
restart. For changes to take effect, you must restart the connector after saving the
revised connector configuration file.

Specifying supported business object definitions

Use the Supported Business Objects tab in Connector Configurator Express to
specify the business objects that the connector will use. You must specify both
generic business objects and application-specific business objects, and you must
specify associations for the maps between the business objects.

For you to specify a supported business object, the business objects and their maps
must exist in the system. Business object definitions, including those for data
handler meta-objects, and map definitions should be saved into Integration
Component Library (ICL) projects. For more information on ICL projects, see the
User Guide for WebSphere Business Integration Server Express.

Note: Some connectors require that certain business objects be specified as
supported in order to perform event notification or additional configuration
(using meta-objects) with their applications. For more information, see the
chapter on business objects in this guide as well as the Business Object
Development Guide.

To specify that a business object definition is supported by the connector, or to
change the support settings for an existing business object definition, click the
Supported Business Objects tab and use the following fields.

Business object name

To designate that a business object definition is supported by the connector, with
System Manager running:

1. Click an empty field in the Business Object Name list. A drop-down list
displays, showing all the business object definitions that exist in the System
Manager project.

2. Click on a business object to add it.

w

Set the Agent Support (described below) for the business object.

4. In the File menu of the Connector Configurator Express window, click Save to
Project. The revised connector definition, including designated support for the
added business object definition, is saved to the project in System Manager.

To delete a business object from the supported list:

1. To select a business object field, click the number to the left of the business
object.

2. From the Edit menu of the Connector Configurator Express window, click
Delete Row. The business object is removed from the list display.

3. From the File menu, click Save to Project.

Deleting a business object from the supported list changes the connector definition
and makes the deleted business object unavailable for use in this implementation
of this connector. It does not affect the connector code, nor does it remove the
business object definition itself from System Manager.

Agent support

If a business object has Agent Support, the system will attempt to use that business
object for delivering data to an application via the connector agent.
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Typically, application-specific business objects for a connector are supported by
that connector’s agent, but generic business objects are not.

To indicate that the business object is supported by the connector agent, check the
Agent Support box. The Connector Configurator Express window does not
validate your Agent Support selections.

Maximum transaction level

The maximum transaction level for a connector is the highest transaction level that
the connector supports.

For most connectors, Best Effort is the only possible choice.

You must restart the server for changes in transaction level to take effect.

Associated maps

Each connector supports a list of business object definitions and their associated
maps that are currently active in InterChange Server Express. This list appears
when you select the Associated Maps tab.

The list of business objects contains the application-specific business object which
the agent supports and the corresponding generic object that the controller sends
to the subscribing collaboration. The association of a map determines which map
will be used to transform the application-specific business object to the generic
business object or the generic business object to the application-specific business
object.

If you are using maps that are uniquely defined for specific source and destination
business objects, the maps will already be associated with their appropriate
business objects when you open the display, and you will not need (or be able) to
change them.

If more than one map is available for use by a supported business object, you will
need to explicitly bind the business object with the map that it should use.

The Associated Maps tab displays the following fields:

* Business Object Name
These are the business objects supported by this connector, as designated in the
Supported Business Objects tab. If you designate additional business objects
under the Supported Business Objects tab, they will be reflected in this list after
you save the changes by choosing Save to Project from the File menu of the
Connector Configurator Express window.

* Associated Maps

The display shows all the maps that have been installed to the system for use
with the supported business objects of the connector. The source business object
for each map is shown to the left of the map name, in the Business Object
Name display.

* Explicit
In some cases, you may need to explicitly bind an associated map.
Explicit binding is required only when more than one map exists for a particular
supported business object. When InterChange Server Express boots, it tries to
automatically bind a map to each supported business object for each connector.
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If more than one map takes as its input the same business object, the server
attempts to locate and bind one map that is the superset of the others.

If there is no map that is the superset of the others, the server will not be able to
bind the business object to a single map, and you will need to set the binding
explicitly.

To explicitly bind a map:

1.

In the Explicit column, place a check in the check box for the map you want
to bind.

2. Select the map that you intend to associate with the business object.
3. In the File menu of the Connector Configurator Express window, click Save
to Project.
4. Deploy the project to InterChange Server Express.
5. Reboot the server for the changes to take effect.
Resources

The Resource tab allows you to set a value that determines whether and to what
extent the connector agent will handle multiple processes concurrently, using
connector agent parallelism.

Not all connectors support this feature. If you are running a connector agent that
was designed in Java to be multi-threaded, you are advised not to use this feature,
since it is usually more efficient to use multiple threads than multiple processes.

Setting trace/log file values

When you open a connector configuration file or a connector definition file,
Connector Configurator Express uses the logging and tracing values of that file as
default values. You can change those values in Connector Configurator Express.

To change the logging and tracing values:
1. Click the Trace/Log Files tab.

2. For either logging or tracing, you can choose to write messages to one or both
of the following:

* To console (STDOUT):

Writes logging or tracing messages to the STDOUT display.

Note: You can only use the STDOUT option from the Trace/Log Files tab for
connectors running on the Windows platform.

To File:

Writes logging or tracing messages to a file that you specify. To specify the
file, click the directory button (ellipsis), navigate to the preferred location,
provide a file name, and click Save. (If your connector is not running on the
Windows platform on which you have installed Connector Configurator
Express, you must first map a drive to a location on the system where you
want the file. ) Logging or tracing message are written to the file and
location that you specify.

Note: Both logging and tracing files are simple text files. You can use the file
extension that you prefer when you set their file names. For tracing
files, however, it is advisable to use the extension .trace rather than
.trc, to avoid confusion with other files that might reside on the
system. For logging files, .10og and .txt are typical file extensions.
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Data handlers

The data handlers section is available for configuration only if you have designated
a value of JMS for DeliveryTransport and a value of JMS for
ContainerManagedEvents. Adapters that make use of the guaranteed event
delivery enable this tab.

See the descriptions under ContainerManagedEvents in the Standard Properties
appendix for values to use for these properties.

Saving your configuration file

After you have created the configuration file and set its properties, you need to
deploy it to the correct location for your connector. Save the configuration in an
ICL project, and use System Manager to load the file into InterChange Server
Express.

The file is saved as an XML document. You can save the XML document in three

ways:

* From System Manager, as a file with a *.con extension in an Integration
Component Library, or

* In a directory that you specify.

¢ In stand-alone mode, as a file with a *.cfg extension in a directory folder.

For details about using projects in System Manager, and for further information
about deployment, see the User Guide for IBM WebSphere Business Integration Server
Express.

Completing the configuration

After you have created a configuration file for a connector and modified it, make
sure that the connector can locate the configuration file when the connector starts

up.

To do so, open the startup file used for the connector, and verify that the location
and file name used for the connector configuration file match exactly the name you
have given the file and the directory or path where you have placed it.

Using Connector Configurator Express in a globalized environment

Connector Configurator Express is globalized and can handle character conversion
between the configuration file and the integration broker. Connector Configurator
Express uses native encoding. When it writes to the configuration file, it uses
UTF-8 encoding.

Connector Configurator Express supports non-English characters in:

* All value fields

* Log file and trace file path (specified in the Trace/Log files tab)

The drop list for the CharacterEncoding and Locale standard configuration
properties displays only a subset of supported values. To add other values to the

drop list, you must manually modify the \Data\Std\stdConnProps.xml file in the
product directory.
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For example, to add the locale en_GB to the list of values for the Locale property,
open the stdConnProps.xml file and add the line in boldface type below:

<Property name="Locale"
isRequired="true"

updateMethod="component restart">
<ValidType>String</ValidType>

<ValidValues>

<DefaultValue>en US</DefaultValue>

</ValidValues>
</Property>

<Value>ja_JP</Value>
<Value>ko_KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr_FR</Value>
<Value>de DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>
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Appendix C. XML adapter sample scenarios

Consider the situation in which a company wants to use the WebSphere Business
Integration Server Express Adapter for XML to read XML documents from and
post XML documents to Web Servers. Below is a sample scenario designed to be
simple and show the basic points of the XML Adapter’s functionality with
InterChange Server Express connectivity.

This fictitious scenario involves two integrations that represent the two directions
of data exchange:

The first integration starts with an “XML_REQUEST_Order” object sent from the
PortConnector to the XML Adapter via the “Port_To_XML" collaboration object.
The XML Adapter will invoke the XML DataHandler to convert the request
business object to an XML Document. The XML is POSTed to a Web server. The
Web server will respond to the XML Adapter, which converts the response XML
to the response business object sent back to InterChange Server Express.

In the second integration, the XML Adapter will poll a URL for an XML
document. Once read, the XML Adapter will send the document through the
XML DataHandler to convert it to a response business object that will be sent to
InterChange Server Express. Then, via one of two collaborations,
“XML_To_Port_Customer” or “XML_To_Port_Manifest,” the events will be sent
to the Port Connector.

Installation of the XML sample scenario with InterChange Server
Express connectivity

Note: In this sample, the poll will return three business objects:

¢ XML_Order_Customer

e XML_Order_Manifest

¢ XML_Order_Receipt

Only two of these business objects have collaborations offering subscriptions

(Customer and Manifest), so the third business object (Receipt) will be
archived by the XML Adapter to a specified location.

The following are the steps for installing and verifying the sample scenario.

Pre-installation notes and assumptions.
Installation of the sample scenario.
Running the service call request scenario.
Running the poll scenario.

Summary.

Pre-installation notes and assumptions

1.

© Copyright IBM Corp. 2004

You have installed and are experienced with WebSphere Business Integration
Server Express Adapters.

You have installed and are experienced with InterChange Server Express.

You have installed the WebSphere Business Integration Server Express Adapter
for XML.
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4. You have a Web server set up to handle java servlets.

5. All environment variables and file separators are specified in the Windows 2000
format.

Installation of the sample scenario

1. Load business objects into repository:

Start InterChange Server Express, and using your WebSphere Business
Integration Server Express System Manager, select the “Open From File” menu
item from the “File” menu of Business Object Designer Express.

— Windows
Load the repository file labeled "Sample_XML_Order_Objects.in” located
in the %CROSSWORLDS%\connectors\XML\Samples\ WebSphere
InterChange Server Express folder.

— Linux
Load the repository file labeled "Sample_XML_Order_Objects.in” located
in the ${CROSSWORLDS}/connectors/ XML /Samples/WebSphere
InterChange Server Express directory.

— 0S/400
Load the repository file labeled "Sample_XML_Order_Objects.in” located
in the
/QIBM/UserData/WBIServer43/interChangeServerName/connectors
/XML /Samples/WebSpherelCS directory.

You must map a network drive from a Windows system to the OS/400
system (in the Map Network Drive dialog box, type \\os400Name\root for
the folder field where 0s400Name is the name or ip address of the OS/400
system). Then they navigate to the drive to find the file.

Confirm that the Business Objects have been loaded. There should be 12 in
total.

2. Load connectors into repository:

Using your WebSphere Business Integration Server Express System Manager,
select the “Open From File” menu item from the “File” menu of Connector
Designer.

Windows
Load the repository file labeled “Sample_XML_Order_Connectors.in”
located in the
%CROSSWORLDS% \ connectors \XML\Samples\WebSpherel nterChange
Server Express folder.
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Linux
Load the repository file labeled “Sample_XML_Order_Connectors.in”
located in the ${CROSSWORLDS}/connectors/XML/Samples/WebSphere
InterChange Server Express directory.

— 0S/400
Load the repository file labeled “Sample_XML_Order_Connectors.in”
located in the
/QIBM/UserData/WBIServer43/interChangeServerName/connectors/
XML/Samples/WebSpherelCS directory.

You must map a network drive from a Windows system to the OS/400
system (in the Map Network Drive dialog box, type \\os400Name\root for
the folder field where 0s400Name is the name or ip address of the OS/400
system). Then they navigate to the drive to find the file.

Confirm that the XMLConnector and PortConnector definitions have been
loaded.

Configure XML connector:

Using your WebSphere Business Integration Server Express System Manager,
double-click on the XML CONNECTOR definition so that the Connector
Designer is launched. The following Application Config Property values need

to be modified for your specific file structure. These paths and/or files need to

be created if they don’t already exist:
* ArchiveDirectory.
. Load collaboration templates and objects into repository:

Using your WebSphere Business Integration Server Express System Manager,
select the “Open From File” menu item from the “File” menu.

— Windows
Load the repository file labeled “Sample_XML_Order_Collaborations.in”
located in the
%CROSSWORLDS%\ connectors \ XML \samples\ WebSpherelCS folder.

— Linux
Load the repository file labeled “Sample_XML_Order_Collaborations.in”
located in the ${CROSSWORLDS}/connectors/XML/Samples/WebSphere
InterChange Server Express directory.
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— 0S/400
Load the repository file labeled “Sample_XML_Order_Collaborations.in”
located in the
/QIBM/UserData/WBIServer43/interChangeServerName/connectors
/XML/Samples/WebSpherelCS directory.

You must map a network drive from a Windows system to the OS/400
system (in the Map Network Drive dialog box, type \\os400Name\root for
the folder field where 0s400Name is the name or ip address of the OS/400
system). Then they navigate to the drive to find the file.

Confirm that three template definitions and three collaboration objects have
been loaded.

5. Compile the collaboration templates:

Using your WebSphere Business Integration Server Express System Manager,
right click on the folder labeled Collaboration Templates and select Compile all
from the drop-down list.

6. Modify the servlets for use in your environment:
The following changes must be made to the servlets:
* For PolIXMLOrder.java:

On line 41 of the source file, the value of the outFileName String must be
changed to be the name of the file on the local system to which the servlet
should log the incoming XML message. On line 56 of the source file, the
value passed to the FileInputStream constructor should be the exact file
name on the local system for the delivered SamplePollingInput.xml file.

* For MirrorXMLOrder.java:
No Changes Necessary.
7. Configure the XML Poll business object:

From WebSphere Business IntegrationServer Express System Manager, open the
business object labeled “XML_POLL_Order.” The first attribute of this business
object should be named “URL.” Change the URL attribute’s default value to the
location to which the XML Adapter will listen for XML responses (i.e.
PolIXMLOrder.java). Save the business object to the server.

8. Configure the Web server:

Compile the delivered servlets. The generated class files should be moved to
the correct directory for the web server to pick them up and run them. Also,
any additional steps to register the servlets should be done (the exact
requirements will depend entirely on the web server being used).

9. InterChange Server Express restart:
Reboot InterChange Server Express to ensure that all changes take effect. Use
the System View from WebSphere Business Integration Server Express System

Manager to ensure that all of the collaboration objects and connector controllers
are in a green state.

Running the service call request scenario
1. Start:

 InterChange Server Express if not already running.
* XML Adapter.
* Web server.
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2.

* One instance of the Visual Test Connector.

Simulate the Port connector:
Using the Test Connector, define a profile for the “PortConnector.” Select FILE
-> CONNECT AGENT from the Test Connector’s menu to begin simulating the
agent.

Load test data:
Using the Test Connector simulating the “PortConnector,” Select EDIT ->
LOAD BO from the menu. Load the sampleOrderData.bo file from one of the
following paths:

* %CROSSWORLDS%\connectors\XML\samples\WebSphereICS (for Windows)

¢ ${CROSSWORLDS}/connectors/XML/samples/WebSpherelCS (for Linux)

e /QIBM/UserData/WBIServerd3/interChangeServerName/connectors/

XML/samples/WebSphereICS (for OS/400)

Set the URL:

Open the test data that was loaded into the Test Connector. Modify the value of
the URL attribute to the location to which the XML Adapter should POST its
xml request.

Send test data:

Using the Test Connector simulating the “PortConnector,” click on the loaded
Test business object. Select REQUEST -> SEND from the menu.

Check for successful processing:

To ensure successful processing, check that the XML Adapter received an event,

converted the business object to an XML document, posted it to the Web server,
received a response, parsed the response, and sent it back to the collaboration.

Running the Poll
1.

scenario

Start

¢ InterChange Server Express if not already running.
* XML Adapter.

* Web server.

* Start one instance of the Visual Test Connector.
Simulate the Port connector:

Using the Test Connector, define a profile for the “PortConnector.” Select FILE
-> CONNECT AGENT from the Test Connector’s menu to begin simulating the
agent.

Poll sample data:

The PollFrequency has already been set to key. From the command window in
which the XML Adapter was started, type the letter 'p’ followed by the Enter
key.

Accept the request using the Port connector:

The XMLConnector will receive an XML document, convert it to a business
object and pass it to InterChange Server Express. InterChange Server Express
passes the event to two different collaborations that have subscriptions for this
event. The collaborations will pass the events to the PortConnector. Accept the
requests using the Test Connector, and reply with a successful response to both
of the events.

Check for successful processing:
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To ensure successful processing, check that the data in the accepted request in
the Test Connector and the Archive Directory correspond to the events from the
SamplePollingInput.xml file provided in the sample.

Summary:

If you performed all the above steps successfully, you should have a working
sample scenario that uses the XML Adapter and XML DataHandler to exchange
XML documents between InterChange Server Express and a Web server.

68 Adapter for XML User Guide



Notices

Notices

IBM may not offer the products, services, or features discussed in this document in
all countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing IBM Corporation North Castle Drive Armonk, NY
10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or program(s) described in this publication
at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Burlingame Laboratory Director IBM Burlingame Laboratory 577 Airport
Blvd., Suite 800 Burlingame, CA 94010 U.S.A
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Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not necessarily tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information may contain examples of data and reports used in daily business

operations. To illustrate them as completely as possible, the examples may include

the names of individuals, companies, brands, and products. All of these names are

fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

COPYRIGHT LICENSE

This information may contain sample application programs in source language,
which illustrates programming techniques on various operating platforms. You
may copy, modify, and distribute these sample programs in any form without
payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the
operating platform for which the sample programs are written. These examples
have not been thoroughly tested under all conditions. IBM, therefore, cannot
guarantee or imply reliability, serviceability, or function of these programs.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.

However, this information may also contain diagnosis, modification, and tuning

information. Diagnosis, modification and tuning information is provided to help
you debug your application software.
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Note: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States or other countries, or both:

IBM

the IBM logo
AIX
CrossWorlds
DB2

DB2 Universal Database
Domino

Lotus

Lotus Notes
MQIntegrator
MQSeries
Tivoli
WebSphere

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

MMX, Pentium, and ProShare are trademarks or registered trademarks of Intel
Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product or service names may be trademarks or service marks of
others.

System Manager includes software developed by the Eclipse Project
(http:/ /www.eclipse.org/)

e
JAVA.

WebSphere Business Integration Server Express V4.3.1 and WebSphere Business
Integration Server Express Plus V4.3.1
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